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1. Close Look into a Certain Region Only

1.1. Using Clipping Box

1.1.1. Viewing within Clipping Box

Users can specify a view area in the point cloud by creating a rectangular solid. This
rectangular solid is called Clipping Box. Users can view data within the Clipping Box, or move
the data to another layer for editing.

Preparing to Create Clipping Box

If the buttons on [Clipping] panel are inactive, activate them by pressing [Switch Mode:
Clipping/Section] (| |) in the upper left of [Clipping] panel.

Clipping | Clipping a
7 o |- & ] ||| €|+ @ =
Hide points outside Clipping Box [1Hide points outside Clipping Box
Show Box Section Mode ] Show Box [ section Mode
Highlight points side [ Highlight points ® side
Top O Top
0 Clipping Box and Section cannot be used at the same time.

1. In [Clipping] panel, press [Create Clipping Box] | |).

Clipping B

t_-"t . _E ;_%-:. — ‘g-.} I‘_ i

[_]Hide points outside Clipping Box
[]5how Box []5ection Mode

2. Pick a point on the screen to select an area to clip out.
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With the selected points in the center, a semi-transparent blue box will appear on "3D View"
window. This box is the "Clipping Box".

3. Left-click and drag the handles that appear around the Clipping Box to adjust the size and
orientation. Types of handles are as follows:

o Handle in the width direction ()

- Handle in the height direction (H)
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- Rotation handle for axis in the depth direction (@)
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By pressing [Restore to Initial Rotation Angle] (| 2* |) in [Clipping]
panel, you can reset the rotation angle of Clipping Box to the initial
state.

1
[1Hide points outside Clipping Box
[1show Box [ 1Section Mode

Right-click and drag the handle with the mouse to parallel move the
Clipping Box without changing the size.

4. When enabling "Hide points outside Clipping Box" in [Clipping] panel, only the elements
inside the Clipping Box are displayed.

R |33 | ~|E] @2

IE Hide points outside Clipping Box I
Show Box Section Mode
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[
A =

1.1.2. Switching to Section Mode

On [Clipping] panel, specify either "Side" or "Top" in Section Mode, and enable "Section Mode"
checkbox.

o If"Side" is selected as the section orientation

Clipping [z

& |v =S -

Hide points outside Clipping Box

Show Box [ ]Section Mode
Highlight points
O Top

» If "Top" is selected as the section orientation

Clipping |
X . ; A
3 [el-]e] (o] =
Hide points outside Clipping Box
[A show Box [ section Mode
Highlight points ) Side
w
< >
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When Clipping Box is in the edit state, the facing section is highlighted on
"3D View" window in Section Mode. If not in the edit state, the section is
temporarily highlighted when you switch the section orientation.

This will switch to Section Mode from a viewpoint that is looking at the specified section from
above.

o If"Side" is selected as the section orientation

Clipping |
. . ; A
5@ [2-]€] [¢][=
Hide points outside Clipping Box
[ show Box [ section Mode
Highlight points (@) Side
O Top
W
< >

» If "Top" is selected as the section orientation

Clipping a
N - . )
|| G| |2 |v &||1F
Hide points outside Clipping Box
[A show Box [A section Mode
Highlight points (_ Side
® Tap
w
< >
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1.2. Using Section View

Users can create sections to specify the display area of the data. A plane is used to create a
section.

Preparing to Create a Section

If the buttons in [Section] panel are inactive, activate them by pressing [Switch Mode:
Clipping/Section] (|&* |) on the upper left of [Section] panel.

Section x| Section x|
8 G || akp v | | G 3 £t || ok || I ‘ v | & '&J L @ .:)
Hide points outside section | | Section Mode [Hide points outside section [_] Section Mode
Display the section Use Curve [] isplay the section Use Curve
Highlight points Auto-align to Z-axis [ Highlight points Auto-align to Z-axis
Display area Display area

* Clipping Box and Section cannot be used at the same time.

* Color, size, etc. of a section can be changed from [Section setting]
(| %# |) in [Section] panel.

Section setting x
Section
Front color: - Transparency: I
Back color: - Transparency: I

Grid element width m

Mumber of grid elements [one direction]

Points in the section:

o Color:

Margin for Points to be Edited: 0.001 m
Concel

® Front (Left) and Back (Right) of a Section
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1.2.1. Creating a Section by Using XY Plane
1. Select [XY(Top)] (| (= _) from the [Section] panel.

Section B

3)%|gl-]4 &) (o5

[1show points wi| ¥ XZ(Front)
[ Display the sect XZ[Back) 0
[IHighlight points ~ yz(Right)
Display area VZ(Left)
Plus side XV(Top) kress
XV (Bottom) -
Move

2. Pick points to create a section on the 3D View Window.

3. A section will be created at the picked point position.

#2 ELYSIUM © 2023 Elysium Page 8 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

> You can switch show/hide of the section in the 3D View Window by
using "Hide points outside section” or "Display the section” in the
[Section] panel.

T
OES

[~ Hide points outside sectionF Section Mode

[~] Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

- Please note that you can adjust the position of the section by clicking

(| 4=

-+

) and moving the slider in the [Section] panel.

Mowe

EE pch 01 5]

Rotate section around Z-axis | 180 %
[ UnitSystem m ]

> On [Section] panel, if you select [Switch the Orientation (Plus/Minus) of
Section] ( /1), you can flip the section’s front and back sides.

Move

|E||E| pitch (0.1 |3 m

Fotate section around Z-axis | 180 ZI

[ UnitSystem m ]
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1.2.2. Creating a Section from Any Plane

1. In [Section] panel, press [Section using selected plane] (| ‘¢ |).

Section X
Al El EYEIE B AR

[ Hide points outside section [ Section Mode
[ Display the section Use Curve
[ Highlight points Auto-align to Z-axis

2. Select an extracted plane where you would like to create the section.

select a plane £ar the section

o Perform [Extract Planes and Pipes] before creating a section.

3. A section will be created at the picked position of the plane.
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1.2.3. Creating a Section by Using [Top]/[Front] Panel

To create a section in [Top View] panel (or [Front View] panel), enable "Enable
Clipping Box/ Section creation by dragging" in [Top View] panel (or [Front
View] panel) settings dialog.

‘ Display slider for view range control

Enable Clipping Box [ Section creation by dragging

Auto Update height when creating Clipping Box

Carcel

1. Users can create section by clicking and dragging the mouse in the [Top] panel or [Front]
panel.

Fit Update &

2. The section will be created on [Top] (or [Front]) panel view.

Top View ﬂ

Fit Update B+

0 The section is displayed by blue line for [Top] or [Front] panel.
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The section will be displayed on the 3D View Window at the same time.

Display Area of Section
You can change the display area of the section by [Section] panel > "Display area".

m Plus side: Display the points in the plus side of the section only

Section % Top View x|
d B EI YR

Hide points outside section [] Section Mode
Display the section Use Curve
Highlight points Auto-align to Z-axis

Display area
O Minus side O With thickness
Thickness |1 =

s = Fit Update -]

Maowve
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® Minus side: Display the points in the minus side of the section only

Section x| Top View =]

5| ik ---_:‘v Al &| (&5

Hide points outside section [] Section Mode
Display the section Use Curve

Highlight points Auto-align to Z-axis
Display area

O Plus side O with thickness
Thickness |1 =

I r— Fit Update &

Maove

m With thickness: Display the points in the section with specified thickness only

Section x| Top View x|
[5]8]~[4]%]2] [o][%

Hide points outside section [] Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

O Plus side O Minus side | ® with thickness
Thickness |1 =

[ms  I= Fit Update &

Move
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1.2.4. Switching Section to Section Mode

1. Set up the section on "3D View" window, and enable both "Hide points outside section" and

"Display the section" on [Section] panel.

Section x|
33|~ 4] 8] 2] (@5
Hide points outside sectionF Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

® plus side (O Minus side (O with thickness

Thickness | 0.1 =
Move

- = pitch | 0.1 =

180

2. Enable "Section Mode" to switch to Section mode. With "XY (Top)" viewpoint, the back side
of the section is displayed, allowing you to confirm the direction of the floor (Below figure

shows the viewpoint from the ceiling looking down at the floor).

Section x|

g %@ 4%z @5
Hide points outside sectiol Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

® Plus side O Minus side O With thickness

Thickness | 0.1 =
Move

- = Pitch | 0.1 =

3. On [Section] panel, select [Switch the Orientation (Plus/Minus) of Section] ( _ ).

Front and back sides of the section will flip, and Section Mode switches accordingly to show
the front side of the section from the "XY(Bottom)" viewpoint (Below figure shows the floor

viewed from the back).

Section
dRERBRDAIOE

Hide points outside section ] Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

®Plusside O Minus side O With thickness

Thickness | 0.1 =
Move

- - Pitch | 0.1 =
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4. On [Section] panel, switch the Display area to "Minus side". The display switches from the
plus side that was displayed earlier to the minus side. You can view the ceiling direction
from the floor as shown in the figure below.

3 a]~[4]®]2] [e][5

Hide points outside section [+] Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

O Plus side I@ Minus side I O with thickness
Thickness | 0.1 =
Move
- = Pitch | 0.1 =
i

Ratate sartinn arnnnd 7-avis | 180 =
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1.3. Saving a Scene

In InfiPoints, the below information can be registered as [Scene]. And you can also register
multiple scenes and switch back and forth.

Information that can be saved in "Scene"

» Viewpoint

» Layer information of Display status/Display color

Display status / Location of CAD Model

Display status / Location of Point Cloud

Clipping Box/Section

Display status of Note / Dimension

1.3.1. Register a Scene
1. Select [Home] tab > [Show/Hide Panels] > [Scene] panel. Scene panel will be displayed.

Learn with Tutorial - o Scene H

_IQ (i'} _ E . Viewpoint

Create  Edit Show / Hide
Zone~ Zone Panels =

Zone v | Tree
¥ | Annotation >

¥ | Dimension

Layer

Background Point Cloud

v Top View

I Scene I + = = Q #

2. Move to the location where you would like to save the view point.
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Q For details about 3D View Window operation, refer to [View Operation] in
[InfiPoints Operation Manual (Data Pre-processing)].

3. In [Scene] panel, press [Add] (| # ). The information enabled in "Item to Restore" dialog is
registered as one scene in the list.

Viewpoint
Scenel

[+]- (w/@

A context menu will be displayed when right-clicking on the scene in the
list. Edit the name of the scene using [Rename].

4. To delete a scene, specify which scene to delete and press [Delete] (| = |).

Viewpoint
Scenel Apply this Scene
Scene2

[#][=] =@

Viewpoint
Scenel

¥ ELYSIUM © 2023 Elysium
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1.3.2. Items to Restore

1. When pressing [Items to Restore] ( 2% ) in [Scene] panel, "Items to Restore" dialog will

appear. Enable the items you wish to apply and click [OK].

[tems to Restore

Viewpoint

Layer information

Visibility

CAD Model
Visibility

Point Cloud
Visibility

Mote: Visibility
Dimension: Visibility
20/3D drawing: Visibility
Pipe: Visibility
Plane: Visibility
Structure: Visibility
Duct: Visibility

Clipping Box [ Section

Display color

Location

Location

Cancel

2. Double-click on the scene in the list to display the specified scene in the 3D View Window.

Use [Apply this scene] in the context menu to switch to a certain viewpoint.

i

2 ELYSIUM © 2023 Elysium

Scene x|
Viewpoint
e
Scenel Apply this Scene
Scene2 Up
Down
Rename
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1.4. Saving an Area of Specified Space

In InfiPoints, an area of space enclosed by a box can be registered as a "Zone". Multiple zones
can be registered, and switched among them.

Zone can be used to achieve the following behavior:
 Displaying the area on "3D View" window or Top View / Front View.
 Searching for notes or models within the area.
* Check if there is another zone that interferes.

1.4.1. Create Zone from Clipping Box

Create a zone in the position of the currently set Clipping Box.

Please ensure to switch [Switch Mode: Clipping / Section] (|<* |) icon to
A [Clipping] in advance, and set Clipping Box at the position where you want to
create a zone.

1. Select [Home] tab > [Zone] > [Create Zone] > [Create from Clipping Box] ( ':l, ) from the
ribbon menu.

— O ey
- . |

I_?_I e l rjﬂrj - —

— -
Create E Create § Edit Show / Hide
Mote~ MNofe Zane~ | Zone Panels =

Mote _, (Create from Clipping Box
]u Create in Section Mode B
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Zone is created at the Clipping Box position.

Newly created zone will appear in the structure tree and [Zone] panel as well as on "3D
View" window.

Owverview Pipe Plane Structure Duct | Import || Expart |
Show  Mame Colar
¥ Zone
E Zone?

1.4.2. Create Zone in Section Mode (Specify horizontal section)
Create a zone by specifying any place you prefer on the horizontal section.

1. Select [Home] tab > [Zone] > [Create Zone] > [Create in Section Mode] ( _IE ) from the ribbon
menu.

- O *
=
Create Edit Show / Hide
Mote - Zone Panels ~
_, Create from Clipping Box
Il Create in Section Mode
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2. "Create Zone in Section Mode" dialog will appear. Select "Create a horizontal section at
specified height", and click [Next].

Create Zone in Section Mode >

Select how to create a section to work on,
(®) Create a horizontal section at specified height
(") Create on a selected plane
(") Use current section [ Clipping Box

[ Next ]| cancel

In "Option" dialog, you can specify Zone color, Zone transparency, Zone thickness from the
section, and Zone axis (Rotation angle). In this case, set the thickness as follows.

'aﬁ Oiption

[+] Set colors randomly
Zone transparency: I A
Zone thickness from the section:

Plus side: 10 % m

Minus side: m
Zone axis (Rotation angle): [dea]

3. Specify an origin of the horizontal plane which will be used as the section on "3D View"
window. Here, pick a point from the floor.
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4. The view on "3D View" window switches to "Section Mode", and the viewpoint is from
above, looking down on a section cut at the floor level.

If the area cut in the section is hard to see, from [Section] panel, enable
"With thickness" of Display Area and adjust the width, making it easier to

See.

Section
8% @] -] 4] 2] [@]l5] 5

Hide points outside section [ Section Mode
Display the section Use Curve

Highlight points Auto-align to Z-axis
Display area

OPlusside O Minus side | ® with thickness

Thickness 0.89162 =
Move

-« = pitch | 0-1 <

180 =

[ UnitSystem m ] v

Specify the aren by selecting I peints for dingonal line

|2 )

)

5. On "3D View" window, click the upper-left position of the zone you want to create, and a
rectangular guide will appear. Then click the lower-right position, and a zone will be

created.

2 ELYSIUM © 2023 Elysium
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6. To continue creating more zones, click the upper left position of the zone that you want to
repeat creating. Press [Cancel the selection and quit this function] ( @ ) to quit.

Overview Pipe  Plane Structure Duct | Impart || Export |
: Model
= i@ oce Show  Mame Colar
=& M zone ]
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1.4.3. Create Zone in Section Mode (Using Clipping Box)

Please ensure to set Clipping Box in advance when you want to create a zone
by switching from Clipping Box to "Section Mode". Refer to "1.1.1, “Viewing
within Clipping Box”" for the setting method.

Clipping x|
. . -~
[“IHide points outside Clipping Box
1 show Box [Jsection Mode
Highlight points O side
@® Top
L
< >

1. Select [Home] tab > [Zone] > [Create Zone] > [Create in Section Mode] ( J= ) from the ribbon
menu.

. - |
i€ "} p=|
. ="
Edit Show / Hide
Moter Mofe Zane Panels =

Create from Clipping Box

—_—

|l Create in Section Mode I [ |

2. "Create Zone in Section Mode" dialog will appear. Select "Use current section / Clipping Box",
and then click [Next].

Create Zone in Section Mode >

Select how to create a section to work on.
() Create a horizontal section at spedified height
() Create on a selected plane

I (®) Use current section / Clipping Box I

In "Option" dialog, you can specify Zone color, Zone transparency, Zone thickness from the
section, and Zone axis (Rotation angle).

#2 ELYSIUM © 2023 Elysium Page 24 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

Option B
ﬂﬂ Option

Zone color: Set color

Set colors randomly

Zone transparency: I %

Fone thickness from the section:

Plus side: 10 = m
Minus side: -1 *m

Zone axis (Rotation angle): 0 = Ideal

3. "Section Mode" orientation ("Side" or "Top") in [Clipping] panel switches the specified
section to be viewed from above orthographically.

Specify the axea by selecting 2 points fox diagonal line

4. On "3D View" window, click on the upper-left position of the zone you want to create, and a
rectangular guide will appear. Then click on the lower right position, and a zone will be
created.

Specify the area by selecting 2 points for disgonal Line

5. To continue creating more zones, click the upper left position of the zone that you want to
repeat creating. Press [Cancel the selection and quit this function] ( Q ) to quit.
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Overview Pipe  Plane Structure Duct
B Muodel
Eli Seans Show  MName Caolor
-
Zone [ Zone [ ]

ane

Filtered_points

1.4.4. Edit Zone

1. Select [Home] tab > [Zone] > [Edit Zone] ( EL ) from the ribbon menu.

- O =
2 H Oz =
Create Edit ; Show / Hide
Mote~ MNote Panels =
MNote
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3. Handles will appear around the specified zone on "3D View" window.
Click and drag the handle with the mouse to adjust the size and orientation of the zone.

0 Please note that this handle operation is the same as that of Clipping Box.
Refer to 1.1.1, “Viewing within Clipping Box” for the operation method.
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2. Editing Point Cloud Color

By editing the image associated with point clouds, the color of point clouds can be corrected.

1. Select [Pre-process] tab > [Point Cloud Color] > [Edit Color] ( "'\..-.» ).

~ FInfiPoints -

Pre-process Analysis Modeling

Cutput Creation

Recent

nt = | 55 iMport External Reference Points = azr.’;+ M4 Color/Intensity Filter :jc:‘
A
BE e == S Ertroeifrem——] e
— e oy
Remowve Edit
,_)5 Renumber Reference Points Maise '] Extract Pole Color

Reference Point

Filter Point Cloud Color

2. Specify the point cloud parts or groups to edit the color in [Tree (Overview)] panel, and

press [Done] ( 0 ).

Tree

Cverview  Pipe  Plane Structu

x |
re  Duct

EI--E Model
=007 Scans
=

20150217A-2
% 20150217A-3
= 20150217A-4
% 20150217A-5
% 20150217A-6
% 20150217A-7
Extracted Plan

[ [} Extracted Piping System

=3

3. "Point Cloud Color" dialog will appear. Select "Edit a Copy" option.

Edit Point Cloud Celor

Please select the Edit option.

Select the Edit optien from the fellowings, and the color-editing dialeg will appear. Point cloud
coler will enly be updated after confirming in that dialeg. Click [Cancel] to exit the command.

—> Edit a Copy

A copy of the selected shots will be created as a new point cloud part (POC file) under
"Color-edited scan”, and edits will be reflected on the copy. The original remains as is, and
this does net affect other revisions. Please note that this will require approximately 3.1 GB
of free space in the drive where the project folder is.

—> Edit the Original

Update the eriginal point cloud part (POC file). This will require ne extra free space. Please
neote that this will affect all revisions including previous ones, and POC files cannot be
reverted to the previous state once updated.

Cancel
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4. "Edit Color in Images" dialog will appear. Specify the image to edit, and select [Open with
Editor] (7). To select multiple images, select the items while holding down [Ctr]] or [Shift]
key.

@ Edit Colorin Images - [m] X

'7 Open with Editor

'; Open with Viewer A Rotate - a

2015021741
201602174-2
201502174-3
201602174-4
2015021745
20160217 4-6
200502174-7

20150217A-2

a

@
o
a?

201502174-2 poc_ime.idx pre

o Confirm the image with the Viewer either by double-clicking the image
on the list, or by specifying the image and select [Open with Viewer]
S
(Fomp).
> Viewer / Editor applications can be changed from [Settings] ( ¥#) at the
top right of "Edit Color in Images" dialog.

Q Settings *

Viewer: | | | Browse..
Arguments (Option) | |
{%F = Image file path)
Editor: | | | Browse..
Arguments (Option) | |

{%F = Image file path)

[ ok ]| cancel |

- Please ensure to always use [Rotate] (Zk ) in "Edit Color in Images"
dialog when changing the direction of image in the list. An error may
occur during the process if you change the direction of the image in the
image viewer or image editor.

' @ Edit Color in Images

o Open with Viewer (7 Open with Editor 7\ Rotate ~

201502174-1 20150217A-1 Ay Rotnte Right 90 Degrees
MIEL217A-2
2015021743
2015021744
2015021745
AMEL217A6
MEL217A-T

A Flip Horizontal
< Flip Vertical
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5. Editor will be launched and the image will be displayed. Overwrite the image after
correcting the image color.

Fhtos - 201502 174-1,pocimgidepng - a M
4 madie a0 S R | 34 ~ = =

‘ Please ensure to update the edited images by saving them.

6. Click [OK] in "Edit Color in Images" dialog.

-

I K || Cancel |

7. When the confirmation dialog appears, click [Yes]. The point cloud color is updated to match
the color of the edited image.

Confirm

Paoint cloud color will be updated based on the edits made on images.

Click [Yes] to continue, or [No] to go back to image editing,

> An example of adjusting the image brightness
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3. Complementing Point Cloud

3.1. Complementing Point Cloud - Under the Scanner

Generally, a floor area where a 3D scanner is placed cannot be scanned, resulting in a blank
area without point cloud. Use the following procedures to create a point cloud to complement
this blank area.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [Floor under Scanner]
(.7

TN e ; % @
it — *

Background Point Cloud with Complement Enable Generate

Point Cloud *  Scan Index~ |Point Cloud ~| Layer Edit Polygon
Optimize I #  Floor under Scanner I
Top View » On Specified Plane

. Space after Removing Object

2. In [Option] panel, specify the mode and adjust the resolution.

>

Option
¢'¢_ Option

How to complement

) As a flat floor

Poinks to regard as plane | 0,005 m
(®) Blend with surroundings

Resolution

Low I High
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o Select "Smooth Connection" to create a point cloud that complements
the surrounding geometry. (bottom left figure)

o Select "Complete the floor as a plane" to create a point cloud that
complements within the specified tolerance without considering the
surrounding geometry. (bottom right figure).

By using resolution, adjusting the resolution of complemented point cloud
is possible.

[Example] Lowest resolution (on left) and highest resolution (on right)

3. Select the point cloud part or group to complement in [Tree (Overview)] panel.

Tree n
Overview Pipe  Plane Structure Duct
-1 Model
E!D Scans
-3 Group?
[ 2015021741
[ 20150217A-2
- 20150217A-3
- 20150217A-4
1% 20150217A-5

[ [} Extracted Piping System
[ e Filtered_points

#2 ELYSIUM © 2023 Elysium Page 32 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

Please note that this function can only be used for point cloud with scan
index data.

‘ InfiPoints >

This command works on point cloud data with the scan index
| data only.

The process to complement the point cloud will start.

Complement the floor under the scanner +
Complementing point cloud. .. 54% completed

Cancel |

4. After completing the process, a new point cloud with scan index data that complements the
floor underneath the scanner is created in [Tree (Overview)] panel.

Tree x|
Overview Pipe  Plane  Structure  Duct
=5 Model

=-f] Scans

=-23 Groupt
% 2015021741
% 20150217A-2
% 20150217A-3
% 20150217A-4
% 20150217A-5
% 20150217A-6
e PONS0ITAT
%, 20150217A-7_floor

[J Extracted Piping System
¥ Filtered_points
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3.2. Removing an Object on the Floor

Points corresponding to the object can be automatically recognized on "3D View" window and
moved to the specified layer.

When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Tree

Overview  Pipe

Plane  Structure  Duct

-8 Model

BD Scans
=-M Groupt
-, 2015021741

[ Filtered_points

Piping System

Please refer to "Learn with Tutorial" > "Vol.1. Data Pre-processing” > [Creating
Point Cloud Data Optimized for Visualization]" for more details about creating

filtered point cloud data.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [Space after Removing

Object] ( .7 ).

Background Point Cloud with| Complement
Point Cloud~  Scan Index~  |Point Cloud =

Optimize -

Top View

-

s D@

Enable Generate
Layer Edit Paolygon

Floor under Scanner

On Specified Plane

rl

Space after Removing Object

2. In [Option] panel, select "On the floor / Away from walls" option.

Option
¢.¢‘ Option

Position of object to remove

(®) On the floor / Away from walls

() On/By the wall(s)

[ ] also separate from the current point cloud part |

[ complement haoles on floorfwall after remaval

2 ELYSIUM © 2023 Elysium
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- Enable "Create a new point cloud from the removed object" to create a
new point cloud part (Removed_object) from the red highlighted points.

o Enable "Auto-complete the created hole" to create a new point cloud
Q part (Inpainted_hole) to complement the hole after object removal.

b )i EXTraCTed Planes
L[| Extracted Piping System
Removed_object
R % Inpainted_hole

3. Select a plane on "3D View" window which will be the floor.

4. Select the highest point on the object from the selected floor.

5. A dialog will appear. Specify the target layer.
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Complement the space after rermoving an object

Target layer

Size of the object to remaove
Small I Large

Ohject's distance from the floor

Near I Far

Dhject's distance From the wall(s)

Mear Far

Cemplement the space after removing an object x
Target layer 10
Size of the object to remove
Smal | Large
Object's distance from the floor
MNear l Far
bpect's distamce From
o< ] [ conce
Cemplement the space after removing an object k4
Target layer b [
Size of the object to remove:
smal | Large
Object's distance from the floor
Mear l Far
biject's i
[oc ] | conce

7. Click [OK] to move the point cloud to the target layer.
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No. of points  C... Cu. ™

A
D Name
03 Too close to the
4 Too far from the
[ds overlapping noist
[J& Front noise
[17 Mixed piel noise
[J& Floating noise
19
10  Equipment0l
=111

90,200 | - I

- - - W

Selectable

£

¥ ELYSIUM © 2023 Elysium
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3.3. Complementing Point Cloud - within Specified
Region

Point cloud which complements the missing part of a specified plane region can be created.

When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Tree ]
Cwerview Pipe  Plane  Structure  Duct
S Model
=-fE3 Scans
=123 Groupt

A, 20150217A1

P 20150217A-7
[ @F Extracted Planes

Piping System

% Filtered_points

Please refer to "Learn with Tutorial" > "Vol.1 Data Pre-processing" > [Creating

Point Cloud Data Optimized for Visualization]" for more details about creating
filtered point cloud data.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [On Specified Plane]
(7).

e Tk - % e
888 — -
Background Paint Cloud with| Complement Enable Generate
Point Cloud =  Scan Index~  |Point Cloud ~| Layer Edit Polygon

Optimize + Floor under Scanner

Top View I » On Specified Plane I

. Space after Removing Object

2. Select "Specified region only" option in [Option] panel.
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Option
'n.‘ﬂ' Option

Where to complement

() The entire plane

(®) Spedified region only

Show points on the plane only

Q Check "The entire plane” option in [Option] panel to create point clouds in
all regions of the selected plane.

3. Select "Blend with surrounding points" in [Option] panel for the coloring method.

Option
'n'ﬁ Option

Where to complement
(") The entire plane
(®) Spedified region only

Show points on the plane only

How to color points
(®) Blend with surrounding points

() In specified color

—
Produce points at every m

When selecting "Specify color" option in [Option] panel, you can set any
color to the newly created point cloud.

Color *
Basic colors:
M N NN
HMrTFEFEEN
ENNEENEEN
¥ ENEEEEEN
EEEEEEEN
EEEEN E
Custom colors:
rrrrrrnr
rrrrrrnr
Define Custom Colors ==
Cancel

4. Select a plane in "3D View" window which will be the floor.
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Finally, click the starting point to begin the process of complementing the point cloud.

Complement on the specified plane

Complementing point doud. .. 26% completed

Cancel

*

6. When processing is completed, a new point cloud part (Inpainted_plane) is created which
complements the area of the plane specified in [Tree Overview)] panel.

Tree x|
Cwerview  Pipe  Plane  Structure  Duct
=& Model
5. Scans
-2 Groupt

2 :‘o‘ 20150217A-1

54 20150217A-7
-[w]@F Extracted Planes
1@ Extracted Piping System

#% Inpainted_plane
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4. Creating and Editing Texture

Texture images can be created from the point clouds for planes and pipes. You can significantly
reduce the view operation of InfiPoints by only displaying the texture without displaying the

point cloud.

When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Tree El
Cwerview Pipe  Plane  Structure  Duct

=-1E Model
E|[:| Scans
2 Group
-5, 507364020
[, LS07364_021

[ LS07364_022
' [ L507364_023
— -5 LS07364_024

-[ ¢ 1507364025
[ L507364_026
- [ LS07364_027
-7 Extracted Planes

- [ _Extracted Piping System
: .&‘}E‘? Filtered_pcints

Please Refer to "Extracting Planes and Pipes" in "Elysium InfiPoints Operation
Manual Vol.1 Data Pre-processing" > [Creating Point Cloud Data Optimized for
Visualization] for details about creating filtered point cloud data.

4.1. Creating Texture Images

It is possible to create texture images from the point clouds for planes or pipes.

4.1.1. Creating Texture Image from Planes
1. Select [Pre-process] tab > [Texture] > [Create] > [All Planes] ( __E ).

Recent Help

M, Color/Intensity Filter °2 5

jc'-l:\l“"J L \,.a'o
T £ Bxtract Ground — -
Remave Extract Planes Edit
Maise ‘W Extract Pole and Fipes Colar
Filter Extract Primitive Caolor

-
=
“& Al Planes

_E Piping Element
2 a1 Piping Elements
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2. "Create Texture for All Planes" dialog will appear. Specify options such as clearance and
resolution, and click [OK].

Create Texture for All Planes X

Use points within this distance from extracted planes/pipes

oo o
Resolution
0.01 mipx

[IMove points for selected element(s) to specified layer
Target laver g
Enhance created texture by image auto-correction
[ Advanced correction using AT <3
[ Exdude elements that already have texture images
[ Exclude hidden elements
[ Exdude elements smaller than the specified value in area size

1 mz

e

- With clearance, you can specify which area of the point cloud from the
plane to use when creating a texture image.

o With resolution, you can specify the actual length that corresponds per
pixel of the texture image (detail texture) to be created. The smaller the
actual length corresponding per pixel, the higher the resolution.

= Resolution 0.01 m/px (Left) and 0.001 m/px (Right)

o When "Enhance created texture by image auto-correction" is enabled,
the quality of the texture image can be improved automatically. This is
effective for areas with low point density.

The process to create texture will start. Required time can be seen in the progress bar. When
you are done, click [OK].
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Create Texture for All Planes *

17% completed / Remaining time: About 23 min

Cancel oK

v

Create Texture for All Planes x

The process has been completed.

Cancel 0K

Texture images are created for all the plane elements.

Please note that when you create texture only for the plane element
O specified in [Plane] ( —% ) and switch to [Texture], the plane element
without texture will be shown in white.

Texture images created on plane elements can be deleted with [Delete] >
[All Planes] ( #% ) or [Selected Element] ( & ).

4 Selected Element
£%  All Planes
[1 41 Piping Elements
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4.1.2. Creating Texture Image from Pipes
1. Select [Pre-process] tab > [Texture] > [Create] > [All Piping Elements] ( ﬁ ).

Recent Help

ot M, Color/Intensity Filter Al
a -
to £ Bdract Ground -
Remaove Extract Planes
Moise "| Extract Pole and Pipes

Filter Extract Primitive

All Piping Elements

2. "Create Texture for All Pipes" dialog will appear. Specify options such as clearance and
resolution, and click [OK].

Create Texture for All Pipes X

Use points within this distance from extracted planes/pipes

0.01 -
Resolution
0.01 mipx

[IMove points for selected element(s) to specified layer
Target laver g

Enhance created texture by image auto-correction
[JAdvanced correction using AI Q

] Exdude elements that already have texture images

[ Exclude hidden elements

[ Exdude elements smaller than the specified value in area size

1 mz

Cancel
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- With clearance, you can specify which area of the point cloud from the
pipe’s surface to use when creating a texture image.

- With resolution, you can specify the actual length that corresponds per
pixel of the texture image (detail texture) to be created. The smaller the
actual length corresponding per pixel, the higher the resolution.

= Resolution 0.01 m/px (Left) and 0.001 m/px (Right)

o When "Enhance created texture by image auto-correction" is enabled,
0 the quality of the texture image can be improved automatically. This is
effective for areas with low point density.

The process to create texture will start. Required time can be seen in the progress bar. When
you are done, click [OK].

Create Texture for All Pipes >

39% completed / Remaining time: About 2 min

Cancel OK

v

Create Texture for All Pipes *

The process has been completed.

Texture images are created for all the piping elements.
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- Please note that "Straight pipe" is the only selection available in [Piping
Element] ( ;q ). Specifying only the connection element is not
available; however, when you create texture on a straight pipe,
adjacent connecting elements will be displayed in a single color similar
0 to the texture of the straight pipe.

- Please note that when you create texture only for the pipe element
specified in [Piping Element] ( ;q ) and switch to [Texture], the pipe
element without texture will be displayed in white.

Texture images created on pipe elements can be deleted with [Delete] > [All
Piping Elements] ( & ) or [Selected Element] ( Eﬂ; ).

Q Recent Help

A4t Selected Element
F% Al Planes

'L All Piping Elements

4.1.3. Toggling between Default Color and Texture
1. Select [Home] tab > [Show / Hide Point Cloud] and click [Hide Point Cloud] ( *+. ).
[ %3 0% % %~ |smart Filter -|  FInfiPoints
Home Impaort Pre-process Analysis Mode

Bl (D &8 sd- om0
Fit

Change |y, - “:  Show Point Cloud R
View = + E

% | Hide Point Cloud

View Operation

Point cloud will be hidden. At this point, the planes and pipes are shown in the state of
default.
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/

2. Select [Home] tab > [Display Status] > [Display Method of Plane Elements] and click
[Texture] ( £¥ ).

|"-‘ (el “: ~ |Smart Filter A ;'T-InfiPDints
Home Import Pre-process Analysis Modeling Cutput Creal

@ @ & @l [ = -lo-oFHe - -# - 8-

Fit  Change P~ |E| ) - @, - ¢ [/ Default Color o

View =

I|E| Texture
View Operation —

The plane on which the texture image is being created switches to texture display.

3. Select [Home] tab > [Display Status] > [Display Method of Piping Elements] and click
[Texture] ( E ).

|,.|q X “: v |Smart Filter - I;Hm‘iPoints-

. Home Import Pre-process Analysis Modeling Cutput Creation Rece
P (3 5= w e SRl

Fit Change 1}, o |[ T | - @, - @ [ - g: Default Color
View ~ . = na - -
sn Classify by Piping Type

View Operation Display 5tz
a sa Highlight Standard Parts
Tree I
= 7 Show Axes of Piping Elements
Owverview Pipe  Plane Structure  Duct |E| E—— I
| =8 Model I_—
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The pipe on which the texture image is being created switches to texture display.
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4.2. Editing Texture Color

It is possible to correct the hue of texture images created on planes and pipes.
1. Select [Pre-process] tab > [Texture] > [Edit] ( ﬂ ).

Recent Help

& . . | = | - o
ac;:\':\+ !. Color/Intensity Filter ":)Q_’.[] fﬂ 4 Edit :af‘ﬂn
— EY

a
_+_° ..‘-'_ Extract Ground
Remove Extract Planes Create Edit
Moise "] Extract Pole and Pipes - Color

Filter Extract Primitive Texture Paint Cloud Caolor

2. On "3D View" window, select a plane element or a piping element whose texture image you
want to edit and press [Done] ( @ ).

3. "Edit Texture Image" dialog will appear. Specify the preferred image to edit, then select
[Edit] > [Detailed Image Only]. To select multiple images, select the images while holding
down [Ctrl] or [Shift] key.

@ Edit Texture Image — O ot

:; Open with Viewer + E ? Edit - h @-
Simple | e Only 1
Both Si and Detailed Images
I Detailed ImageDnIg,rI

Simplelmage_0phne Simplelmage_1pne Simplelmage_2 prg

0] 4 I | Cancel
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o Confirm the image with the Viewer either by double-clicking the image
on the list, or by specifying the image and select [Open with Viewer]

(o).
o Viewer / Editor applications can be changed from [Settings] ( ¥#) at the
top right of "Edit Color in Images" dialog.

Q Settings *
| Browsze...

Wiewer:

freuments (Cption) | |
(%F = Image file path)

Editor: | Browsze...

freuments (Option) |
(%F = Imaee file path)

Garce

4. Editor will be launched and the image will be displayed. Overwrite the image after
correcting the image color.

Photo — Detailling_0.png

a8 See all photos + Addto @

' Please ensure to update the edited images by saving them.

5. In "Edit Texture Image" dialog, click [OK].

Garcel

6. A "Confirmation" dialog will appear. Click [Yes] to update the texture color to match the
color of the edited image.
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2 ELYSIUM © 2023 Elysium

Confirm

All the edits will be applied to each texture image.

Click [Yes] to continue, or [Mo] to go back to image editing.
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5. Move

5.1. Moving Elements/Groups Using Handles

This chapter explains the procedure to move the selected element(s)/group(s) in "3D View"
window using the handles.

1. Select [Analysis] tab > [Move] > [Move] ( L.5 ).

[ #9305 % [ |smart Fitter | EInfiPaints
Home Import Pre-process Analysis Modeling

T’:‘T—g‘a%.j-ﬂ» e :!, )

CAD  Polygon Generate Mowve |Fit to Point | Detect Collision Detec
Model Model CAD- v Claud Mode - Interfere
Impart 7 — I Validate
Tree s Move with Constraint

2. Select the element(s)/group(s) to move in "3D View" window or [Tree (Overview)] panel. The
following image shows an operation of selecting a point cloud part as an example.

Tree ]
Owerview Pipe  Plane  Structure  Duct

=& Model

B|:| sCans
-3 Groupt

- 20150217-1.2fs
[ 20150217-2.2F
[ 20150217-3.1F5
[, 20150217-4.2fs

Select a group in [Tree (Overview)] panel to move per group.

Tree H

Overview  Pipe  Plane  Structure  Duct

=215 Model
=M scan

S[8] Group|
o o0

o

Q When a point is selected on "3D View" window, point cloud part containing
the selected point is moved.

Point Cloud
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The handles will appear for the selected element(s)/group(s).

0 Left-drag the yellow handle ((J) to move parallel, and the blue handle (@#§)
to rotate.

3. [Move] panel will also appear. Select "Rotation axis" as the orientation.

Parallel move  Rotation move

® Reltve () Absolute World coordinate system

Translate distance X | i ‘M ¥ | 0 |M z | 0 |m & | (m)
Pitch 0.1 = (m)

Orientation: @ Rotation axis§O X¥(Top) O YZ(Right) O XZ(Front) = Section

Mo Snap Move Restore Clear

4. Change the view orientation to [XZ(Front)] from [Home] tab > [Change View].

Smart Filter | FInfil
Home Import Pre-process Analys

541-;5. = =Gl

Fit Change _‘). =

- - ., -

V|ew =
Tree _' ¥Z(Back) o

5. Drag the yellow handle along the red axis (the world coordinate X axis).

#2 ELYSIUM © 2023 Elysium Page 53 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

The selected element(s)/group(s) will move parallel to the world coordinate X axis.

7. Change the view orientation to [XY(Top)] from [Home] tab > [Change View].

2
Home Impart

2 ELYSIUM © 2023 Elysium

Sl

Fit Change _‘}, =

Smart Filter *  FInfiPy
Pre-process Analys
| -
- | - -
Di
n

View ~
Mis 1] xZ(Front)
Tree ] ¥Z(Back]
Overviey (111 ¥Z(Right)

=5 | ¥Z(Left)

| ¥¥(Bottom)

tructure Duct
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8. Drag the yellow handle along the green axis (the world coordinate Y axis).

9. Drag the blue handle.
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5.2. Moving Elements/Groups Using [Move] Panel

This chapter explains the procedure to move the selected element(s)/group(s) in "3D View"
window using [Move] panel.

5.2.1. Moving Parallel

1. Select [Analysis] tab > [Move] > [Move] ( 5.5 ).

o | Smart Filter | EinfiPoints
Home Import Pre-process Analysis Modeling

MR F BEH O F

CAD  Polygon Generate Mowve |Fit to Point | Detect Collision Detec

Model Model CAD- v Claud Mode - Interfere
Impart I_'. s I Validate
Tree ~i+ Move with Constraint

2. Select the element(s)/group(s) to move in "3D View" window or [Tree (Overview)] panel. The

following image shows an operation of selecting a point cloud part as an example.

Tree ]
Owerview Pipe  Plane  Structure  Duct

=51 = Model
B|:| sCans
-3 Group
- 310“{; 20150217-1.zfs
é 20150217-2.2fs

[ 20150217-3.1F5
(%, 20150217-4.2f5
[ 20150217-5.2F
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Move H
Parallel move  Rotation move

®Reltive O Absolute World coordinate system
Translate distance X | a ‘M ¥ | 0 |M z | o |m & | (m)
)

Pitch 0.1 = (m

Orientation: (@ Rotation axis (O XY(Top) O YZ(Right) O XZ(Front)

_____

Mo Snap Move Restore

3. Change the view orientation to [XZ(Front)] from [Home] tab > [Change View].

| smart Filter = FInfiP
Home Import Pre-process Analys
@ ; 54-" ] Z. . = W

Fit Change|

& - M ~ - -
view= | ¥ : !
Vil 1] xzZ(Front) Di
Tree ¥Z(Back) o

4. Specify the distance to move at "Translate distance" fields in [Move (Parallel Move)] panel
with "Relative" option selected.

Parallel move  Rotation move

® Relative (O Absolute World coordinate system
Translate distance | X | 2 ‘M Y | 0 |M z | a |m 8 | (m)
Pitch . = (m)

Orientation: @) Rotation axs O XY(Top) O YZ(Right) O X2Z(Front) | Section

Mo Snap Restore Clear

The selected element(s)/group(s) will move parallel to the world coordinate X axis.
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* In [Move (Parallel Move)] panel, specify the destination by either of the followings.

- With "Relative" option, specify the distance to move along X/Y/Z axes by relative
values to the current location.

o With "Absolute" option, specify the destination by the world coordinate X/Y/Z
values.

Maove H

Parallel move Rotation move

(O absolute World coordinate system
Translate distance X ‘ o ‘m ¥ ‘ 0 |m z ‘ a ‘m 2 (m)

B

Move H

Parallel move Raotation move
O Reltive | ® Absolute World coordinate system

Destination X 2.14nzm ‘f\””‘ﬂ z‘u.asm‘ﬂ Iz | (m)
|

"Translate distance" fields will switch to "Destination” fields when

O switching to "Absolute" option, and the world coordinate X/Y/Z
values of the selected element (the location of the yellow handle)
will be auto-set.

e Hold (M) next to each X/Y/Z field of "Translate distance"/"Destination", and drag the
slider to specify the distance to move / the destination.

Move % |

Parallel move  Rotation move

® Reltive (O Absolute World coordinate systermn

|U|| z[o 0] [fm

Translte distance X | 1.400 ”7

Pitch
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* Pitch: Specify the scale of the slider.

Parallel move  Rotation move

@ Reltive O Absolute World coordinate system

Translate distance X | 1.400 |ﬁ Y|U |m Z|D |m 2| (m)
Pitch 0.1 = (m)

 Orientation: Specify the reference axes/plane to move along.

- Rotation axis: Select this option to move parallel to X/Y/Z axes along the rotation
axes.

o XY(Top)/YZ(Right)/XZ(Front): Select this option to move along XY/YZ/XZ plane.
XY/YZ/XZ plane will be set using the corresponding rotation axes.

Orientation: (O Rotation axis| ® X¥( Top)}fO YZ(Right) O XZ(Front)  Section

Snap Angle:

No Snap v Move Restore Clear

o Section: Select this option to move along the section.

Orientation: O Rotation axis O XY(Top) O YZ(Right) O Xz(Front

Snap Angle:
Mo Snap ~ Move Restore Clear
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ﬁ Please note that this option is available only when [Section] panel is
activated.

+* Snap Angle: Specify the snap angle for the move on the selected orientation.

Orientation: () Rotation axis ® XY(Top)
Snap Angle:

Mo Snap v

Every 90 degrees
Every 45 degrees

Eveg 15 deirees

5.2.2. Rotate

1. Select [Analysis] tab > [Move] > [Move] ( [.5 ).

|43 0% 5[] smart Fitter | FInfiPoints
Home Import Pre-process Analysis Modeling

DY B 0 D

CAD  Polygon Generate Move |Fit to Point  Detect Collision Detec
Model Model CAD~ 4 Claud Mode - Interfere
Impart T — I Validate
Tree e Move with Constraint

2. Select the element(s)/group(s) to move in "3D View" window or [Tree (Overview)] panel. The
following image shows an operation of selecting a point cloud part as an example.

Tree H
Crerview  Pipe  Plane  Structure  Duct

=- & Model
=-3 scans
E-ME3 Group
-[A5%, 20150217-1.2fs
[ 20150217-2.1F5
- 20150217-3.2fs
- [, 20150217-4.2f5
[ 20150217-5.1F5

A
! I

The handles will appear for the selected element(s)/group(s).
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3. [Move] panel will also appear. Select [Move (Rotation move)] panel.

Mowve H
Parallel movel Rotation move
Vorld coordinate system
Rotation axis X|U |Y|D |Z|1 ‘ ~ 71?4|v

Rotation center X | 1.785 | Yy | 2.405 | z | 0.265 ‘ x| (m)

Rotation angle Elm (deg)

Move Restore Clear

4. Select the rotation axis from the pull-down list next to "Rotation axis" fields.

Parallel move Rotation move

World coordinate system

Rotation axis X | 0 | K | 0 | z | 1 | :
Rotation center X |1.?85 | Y | 2.405 | z | 0.365 | R Rotate along X Axisf{World
Rotation angle Elm (de) Rotate along ¥ Axis (World
+~ Rotate along Z Axis (World
Mave R Rotate along X Axis (Local

Rotate along ¥ Axis (Local

Rotate along £ Axis (Local

v

Move H
Parallel move Rotation move
World coordinate system
Rotation axis ¥ | 0 | 7 | 0 | A 7[4 =

Rotation center X | 3.185 ¥ |2-4U5 | z | 0.365 | x| (m)

Rotation angle Elm (deq)

Move Restore Clear
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Rotate along X Axis (World Coordinate System)

Select this option to rotate along the world coordinate X axis.

L
Rotate along X Axis 0
[(WCS) ¥

Rotate along Y Axis (World Coordinate System)

Select this option to rotate along the world coordinate Y axis.

e

Rotate along ¥ Axis
X (WCs)

Rotate along Z Axis (World Coordinate System)

Select this option to rotate along the world coordinate Z axis.

Rotate along Z Axis
(WCS)

5. Click [Set in "3D View" Window | l¥ ] next to "Rotation center" fields.
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Parallel move Rotation move
World coordinate system
Rotation axis x|1 |‘~r|D |Z|EI ‘ é]L7|4|v
Rotation center X |3.185 | v {2405 | z|0.365 ||/ ¥ | (m)

Rotation angle EIM (deq)

Move Restore Clear

6. Select an element in "3D View" window to set the rotation center.

G

v

The rotation center will be set at the specified location, and X/Y/Z values of "Rotation center
fields will be updated.

Parallel move Rotation maove

World coordinate system

Rotation axis X | 71“ | b
Rotation center ){ —1IJ 83254 Y 31 14417 z —IZI 28288 [;3 (m)
Rotation angle (deq)

Move Restore Clear

7. Hold (M) next to "Rotation angle" field, and drag the slider to specify the rotation angle.
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Parallel move Rotation move
World coordinate system
Rotation axis X | 1 Rk | z[o ERE

Rotation center X | 0.37474 | v |1.864366| 7 |-0.14475¢ [y | (m)

Rotation angle

Move Restore Clear

8. Click [Move] to rotate the selected element by the angle set in "Rotation angle" field.

Parallel move Rotation move
World coordinate system
Rotation axis x|1 |‘r|D |Z|D ‘ A 7|"’|v
Rotation center X | 0.37474 | v | 1.864366| 7 |-0.14475¢ I3 | (m)

Rotation angle 45.00( ’EINEQ]

Move Restore Clear
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5.3. Position the CAD Model in Place

Position the CAD model based on the specified plane or cylinder’s center axis.

1. Select [Analysis] tab > [Move with Constraint] ( L2 ) from the Ribbon menu.

- .

Home Import Pre-process Analysis Modeling

NP 3B € 4

CAD  Polygon Generate Move Fitto Point | Detect Collision  Dete

Model Model CAD~ = Cloud Mode = Interfer
Import 232 Mave Validate
Tree |£\H Move with Constraint

‘ Owerview  Pipe Plane & Move to Specified Point

2. Select the CAD model to move in "3D View" window.

‘ The only elements allowed to use [Move with constraints] are "CAD model"
—_ and "plane group".

3. "Move with constraint" dialog will appear. Press [Constraints by axis] (| {# ) from the
conditions for constraints.

Move with constraint >

Conditions for constraints

a[Ee

[JFit to horizontal or vertical direction.

+[v 6
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4, Select a face of the CAD model to be the base.

0 The only face that can be selected is cylindrical face.

5. Select one piping element whose axis should be aligned with the center axis of the
cylindrical face specified in the CAD model.

CAD model will move as the center axis of CAD model’s cylindrical face which overlaps the
center axis of the specified piping element.

6. Press [Constraint by plane] (/& ) from the conditions for constraints.
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Mowe with constraint >

Conditions for constraints

[C]Fit to horizental or vertical direction.

Axis : Direction =
(-0.012576, 0.010058, 0.999370)

+| 0] W]

7. Select a face of the CAD model to be the base.

8. Select one plane to match the basic face of the CAD model.

CAD model will move to match the specified plane and the reference face of CAD model.

#2 ELYSIUM © 2023 Elysium Page 67 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

9. At the same time, "Set offset" dialog will appear. In this case, specify "-0.1" (m) as the offset
distance, and click [OK].

Set offset bt
Offset distance -0.1 £ m
‘ Reverse | | oK | | Cancel |

0 If you do not want to set a gap between the specified plane and the CAD
model, leave the offset distance as "0 (zero)" and click [OK].

Moving parallel (|4 ) or rotating the target model (|4 |) can even be
done with constraint by plane or constraints by axis.

Q Motion

+ V|
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6. Edit Layers

In [Layer] panel, the following operations can be performed by classifying points in the point
cloud part into layers.

Toggle show / hide the points per layer

* When all layers are shown

Layer x|
P| |
D Name No... Color *
0 General -
1 Noise -

2 Ground

3 Too close to the scanner
4 Too far from the scanner
5 Overlapping noise

6 Front noise

7 Mixed pixel noise

8§ Floating noise

* When some layers are hidden

Layer B
Pl |
D Name Mo... Color ®
0 General -
11 moise -

)

)
2 Ground (-}
[J3 Too close to the scanner, -y -
[J4 Too far from the scanner -} -
[15 overapping noise (-)
& Front noise )
07 Mixed pixel noise (-}
[1& Floating noise (-)

Set color per layer

Layer a
P |

D Name No... Colorl Colorz ™
10 Equipment oy |
11 () - -
12 ) - -
13 )
14 )
15 )
16 -} - -
()
()

M 17
18

G
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The following functions are available when classifying each point in a point cloud part into
layers.

* Remove noise
Point cloud can be classified into each layer automatically according to the noise type.

Layer H
P |
D Hame Mo. of.. Cc™

0 General (-)

1 HMoise (-)

2 Ground (-)
[0z Too close to the scanner (-)
[0 4 Too far from the scanner (-)
[15 o0Overlapping noise (-)
[1& Front noise (-)
[17 Mixed pixel noise (-)
[0 8 Floating noise ) -
9 -} -~
< >
Show/Hide YaLL v
Selectable ALL o

 Editing with [Layer] panel
Point cloud can be manually classified into each layer, such as specifying a region or object,
and moving the surrounding points to a specified layer.
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6.1. Move Points in Layers

Move the point cloud to the specified layer.

m Change the layer by specifying the area

On "3D View" window, enclose the area you want to move by the function [Rectangle], and
move the point cloud enclosed in rectangle to another layer.

1. Select [Pre-process] > [Layer] > [Enable Layer Edit] ( ’-__@ ) from the Ribbon menu.

- O *
n'f?:: _::‘___ s
* e = W ® 3
Background Point Cloud with Complement Enable JGenerate
2pint Cloud~  Scan Index~  Paint Cloud = | |Layer Edit} Polygon
Optimize Layer

2. [Layer] panel is displayed in editing mode. Select the layer number in "Target Layer" to
which the point cloud will be moved. The selected layer will have a "yellow" background
color in the list.

Layer H
A| |
ID Mamea Mo. of points  Color ™

0 General 259,063,555 -

1 Moise s e

[1z Ground - - v
< >
Show/Hide waLL Vo

Selectable L Ll

How to select points

- €& B

Target Layer 1 w
Target Layer (Press Shift)

Disable Layer Edit x|

In [Layer] panel, you can specify the target layer for the point cloud in two
places: "Target Layer" and "Target Layer (Press Shift)".

Q The point cloud selected while pressing [Shift] key is registered in the layer
specified in "Target Layer (Press SHIFT)". For the layer specified in "Target
Layer (Press Shift)", the background color in the list will be "light green".
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If an unused layer is selected, the "Change Name" dialog will appear.

Specify a layer name.

0 Change Mame

The name can also be changed from the context menu by right-clicking on
the name of each layer, then changing the layer name from "Rename".

Layer x|
¥ ? |
D Narme Mo... Colorl Colorz ™
%110 | Fqupmage Lol
11 Change Name
12 Set As Target Layer
13 Set As Target Layer for Shift Ki

3. The [Clipping Box/Section] ( 1=} ) is selected in the [How to select points] panel.

How to select points
IR I IRdNE = Al <

I +  Rectangle

Free Farm
Target Layer (Press Shift)

Disable Layer Edit x|

On "3D View" window, hold down [Ctrl] key + left-click the mouse button and drag to select
the area. The inside of the rectangular area, which is enclosed with a white line, can be

previewed on "3D View" window.
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You can also restrict the depth of the rectangular area in [Option] panel.

Option
ﬁﬂ Ciption

Q () Mo restriction on the depth

&

(®) Restrict the depth to

m

() Target a single abject only

When you release left mouse button, the point cloud moves to the layer specified by "Target

Layer".
Layer H
P
ID Name Mo. of points  Color: ™
0 General 258,903,776
[J1  Moise 171,639 -
L1Z Ground - W

Point cloud which you selected by dragging while holding down [Ctr]] key +
[Shift] key + left mouse button on "3D View" window moves to the layer

specified in "Target Layer (Press Shift)".

Q Target Layer

Target Layer (Press Shift) o -

Disable Layer Edit
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® Changing the Layer with Clipping Box
Use Clipping Box to trim and divide the point cloud of facility to another layer.

1. Select [Pre-process] > [Layer] > [Enable Layer Edit] ( ’-:fg ) from the Ribbon menu.

- O *
_.:co.&r E‘Uc‘oo , % =7
i — * @
Background Point Cloud with Complement Enable jGenerate
Pgint Cloud >~ Scan Index~  Point Cloud = | |Layer Edit} Palygon
Optimize Layer

2. [Layer] panel is displayed in editing mode.
Set the layer number for "Target Layer" so the equipment’s point cloud will move there.

Layer n
P |
D Mame Mo... Colorl Colorz ™
10 Equipment ) - -

1 ) - -
12 () - . v

Show/Hide A Vo

Selectable AL ey

How to select points

]
Ebl v €~ Bx -
Target Layer 10 -
Target Layer (Press Shift)
Disable Layer Edit x|

3. The [Clipping Box/Section] (| £} ) is selected in the [How to select points] panel.

How to select points

Target Layer 10w
Target Layer (Press Shift)
Disable Layer Edit [X]

"Edit Points (Clipping Box / Section)" dialog will appear.
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Edit Points (Clip Box / Section) *

Spedfy points to move

{®) By Clipping Box
O By section

Create a Clipping Box with [Create Clipping Box] command
above, and then dick [OK] to proceed.

Click [OK] while holding down [Shift] key to move the selected

points to the layer spedfied at "Target Layer (Press [Shift])",
otherwise, the selected points will be moved to "Taraget Layer™.

OK Cancel

4. Users can specify a point cloud area using the [Create Clipping Box] (
(Clipping Box / Section)" dialog.

Edit Points (Clip Box / Section)

Spedfy points to move

(®) By Clipping Box D

() By section

Create a Clipping Box with [Create Clipping Box]

) in "Edit Points

Specify the range of Clipping Box on "3D View" window, and press [Done] ( Q ).

Q Please refer to "Viewing within Clipping Box" for ways to create a Clipping

Box.

5. In "Edit Points (Clipping Box / Section)" dialog, select "By Clipping Box" and click [OK].
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Spedfy points to move

{®) By Clipping Box

O By sedtion

Create a Clippifg Box with [Create Clipping Box] command
above, and thgh dick [OK] to proceed.

Click [0K] while holding down [Shift] k'e'tmove the selected

points to the layer spedfied at "Target Ldyer (Press [Shift])",
otherwise, the selected points will be d to "Target Layer”.

OK Cancel

Edit Points (Clip Box / Section) *

The point cloud in Clipping Box will move to the specified layer.

Point clouds can be selected by using the following ways as well as

[Clipping Box/Section] (| {7}

o Rectangle (|1} ), Free Form ( {7 )
> Sphere ( ), Cylinder ( 1)
Q > Piping Group ( [£¥ ), All Piping Elements ( 1)
o Plane ( £k ), All Planes (| /£k )
> Duct Group ( 35_.;_:3& ), All Duct Elements ( £% )
> CAD Model ( (£} ), All CAD Models (/&% )
> Polygon Model ( ¥ ), Polygon Models (| &k )
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6.2. Copy Point Cloud Element of Layer

New point cloud part can be created from a point cloud separated into other layer.

1. Move only the point cloud, which will be copied to new point cloud part, to any layer.

2. Right-click on the target layer of which the moved point cloud belongs, and select "Copy to
new point cloud” in the context menu.

Layer H
| |
ID Mame Mo... Colorl Colorz ™
mn__
11 Change Mame
12 Set As Target Layer
13 Set As Target Layer for Shift Key
14
15 Set Color £1
16 Set Color #2
17' Clear Color 21 #2
] 18
— Clear Color #2
<
Set Selectable
ShowfHide
Clear Selectable
Selectable Generate Polygon from Point Cloud.

Copy to new point cloud

3. The following dialog will appear.
Specify the target layer and the maximum number of points for the point cloud part to be
created, and click [OK].

Confirmation

Do you want to create a new point doud by copying points
in this layer? (It might take some time.}

Target layer 11 e

Alert when the number of points exceeds;

| 30000000 paints

oK Cancel

Creation of point cloud part will start.

Copy to new point cloud *

Copying selected points to a new point doud part... 40%

Cancel 0K
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If the copied points exceed the specified number of points, a confirmation

dialog appears.

Click [OK] to proceed with the process.

i

Confirmation

*

The number of points to copy exceeds 30000000. This
will take long to complete. Do you wish to continue?

Cancel

4. Once the point cloud part has been created, it will appear on [Tree Panel (Overview)] panel.

Tree

Cverview

Pipe Plane Structure Duct

EI--E Model
-5 Scans
=] Groupl

-5, LS07364 020
-[A% LS0T364_021
[, 1507364 022
[l LS07364_023
[ LS07364_024
[, LS07364 025
-[A% LS07364_026

-
o
< 7oy

[ Extracted Piping Systern

Created point cloud part will move to the layer specified as target in [Layer] panel.

Layer B
A |
D MNarme Mo. of points  Colorl  Colo1 ™
10 Eguipment (-] - —
11 Equipment {(-) - - |
12 -y - -
13 ) - -
14 () - )
15 -} - -
£ >
Show/Hide VaLL Vo
Selectable SaLL e
o Point cloud part name and layer name are the same as the layer name for
which "Copy to new point cloud" was executed.
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6.3. Confirm the Number of Points in the Layer

The number of points per layer can be confirmed.

1. Right-click on the layer, and then select [Calculate Number of Points] from the context
menu.

Layer E
| |
D Mame Mo. of points  Colort ¢ ™

Change Mame

1 MNoise

2 Ground Set As Target Layer

3 Too close Set As Target Layer for Shift Key
4 Toofarfri e

S5 Overlappir eler

6  Front nois Set Color #2

7 WMixed pixe Clear Color#1 #£2

8  Floating n Clear Color #2

9

10 Equipmen Set Selectable

11 Clear Selectable

< Generate Pelygon from Point Cloud...

Show/Hide Copy to new point cloud
Selectable Calculate Area Projected on Horizontal Plane
Generate Ground Palygon from Point Cloud...

Select All
Calculate Number of Points

Number of points is displayed in the "No. of points" column of [Layer] panel.

Layer % |
P |
D Name Mao. of points  Colorl (™
255,637,506 - |
1 Noise 2,283,059 - -
2  Ground - - -
3 Too close to the ... 752,613 - -
4 Too far from the ... 135 - -
5 Overlapping noise 57,251,126 - -
&  Front noise 1,619,486 - -
7 Mixed pixel noise 1,642,820 - -
8  Floating noise 15,399,863 - -
9 - |- -
10 Equipment 1,142,990 - -

11 - - -y
< >
Showy/Hide A v

Selectable SaLL lv]

When switching show / hide of point cloud in [Tree (Overview)] panel, the number of points
changes according to the layer.

- When all point cloud parts are displayed in the structure tree
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Overview Pipe  Plane Structure Duct
=51 Model

8 LS07364_021

% LS07364 022

6 LS07364_023

% LS07364_024

6 LS07364_025

°° LS07364_026

% 1507364 027

- \w/|ZF Extracted Planes

[/ [J Extracted Piping System

A |
D Name Mo. of points € %
Mo Generml 255,637,506 ) -
(11 Hoise 2,283,059 | -
02 Ground -1-
(13 Too dose to the.. 752,613 -
(14  Too far from the.. 1350 -
(15 overkpping noise | 57,251,126 -
(16 Front noise 1,619,486 -
07 Mixed pixel noise 1,642,820 -
(08 Floating noise 15,399,863 -
Mg -

L4 >

Showy/Hide | W, ‘ | Vo ‘
Selactable | “aL ‘ | e ‘

- When portion of point cloud part is displayed in the structure tree

Overview Pipe Plane Structure Duct p| |
Model
= @E ooe D Narme Mo. of points (™
=7 Scans
&5 Groupt Mo  Generl 126,195,857 | -
T3k LS07364 020 01 Noise 723,817 -
Dk 1507364 021 02 Ground -1-
=¥ Lsor3e4 022 03 Too cose to the.. 554,397 | -
[ Lso7364 023 04 Toofar from the.. 36] -
=1 Lso7364 024 Os D\rerlapp.lng noise || 30,729,704 | -
Ak Lso7364 025 Oe Frlont nose 720,145] -
-k Lso7e4 026 7 M[xet_i p[xel.nose 811,218] -
[ Lso7364 027 []&8 Floating noise 7,826,661 ) -
;|77 Extracted Planes l:_/l 9 }_
[ ] Extracted Piping System
Show/Hide | Yare ‘ | vo ‘
Selectable | AL ‘ | e ‘
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6.4. Layer Panel Basic Operation

6.4.1. Toggle Layer Display

Toggle show/hide the point cloud in each layer. For example, by hiding layers classified as noise,
the noise point cloud on "3D View" window will not appear, and improves the appearance.

1. Check Off the checkbox of each layer to hide the point cloud classified to that layer on "3D
View" window.

o When all layers are shown

Layer x|
Pl |

D Name Mo... Color ™
0 General

1 MNoise

2 Ground

3 Too close to the scanner
4 Too far from the scanner
5 Overlapping noise

& Front noise

7 Mixed pixel noise

8 Floating noise

e s s s e e ]
oSN

o When noise layer is hidden

Layer A
P |

D Name Mo... Calor ™
0 General

1 noise

2 Ground

[03 Too close to the scanner
[J4 Too far from the scanner
[O5 overlapping noise

[J6 Front noise

[17 Mixed pixel noise

[18 Floating noise

0 Hidden point cloud layers will not be used to process data such as in the
case of feature extraction.

If you click [All Show] in "Selectable", all checkboxes can be enabled at
once. Also, if you click [Invert Show], you can invert the On / Off status.

9 ) - w

< >
IShol.'J,l'Hide L Vo I
Selectable “ALL o
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6.4.2. Searching for Layers

You can search for layers in the layer list.

When the search box at the top of [Layer] panel is blank, all layers will appear in the layer list.
When entering a string in the search box, only the layers whose "name" contains the string will
be displayed in the layer list.

 When the search box is blank

P

D Mame Mo. of points ™
Mo General 75,468,505
M1  MNoie -
2  Ground -
M3 Too close to the scanner 106
4  Too far from the scanner 36
15  Overlapping noise 1,449,860
6  Front noise 234,969
M7 Mixed pixel noise 116,725
8 Floating noise 1,487,904
Mg - |
£ >
Show/Hide ‘ Yaw | | Vo |
Selectable ‘ AL | | o |

* When a string is entered in the search box

in] Mame Na. of points
M1 MNoise -
5  Overlapping noise 1,449,860
&  Front noise 234,969
M7 Mixed pixel noise 116,725
M8  Floating noise 1,487,904
£ >
Show/Hide ‘ Yare | | Vo |
Selectable ‘ A | | e |
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6.4.3. Set Layer Color
Specific color can be set for each layer.

Layers without any color settings will be displayed as ‘-’ and the points will be displayed in
original colors.

1. Right-click on a layer, then select [Set Color #1] in the context menu.

Layer H
Pl |

D Mame Mo. Colorl Colorz |

10

E Clsead Change MName

12 Set As Target Layer

13 Set As Target Layer for S
14

r

15 Set Color #1

16 Set Color 22

17 Clear Color #1 #2

18 Clear Color 22

19

20 Set Selectable

2. A "Color" dialog will appear. Specify the color you want to set, and click [OK].

¥

Color

m
b
&,
Q
Q
&
o
i

iu]

el el
_NeEl el
BN N N BN BN BN O
e N N NN
BN BN B BN B .
N el

Custom colors:

171
171
171
171
171
171
171
171

Define Custom Colors ==

Cancel|

jm]
-

Also, the "Color" dialog will appear when left-clicking a layer’s "Color 1"
column.

Layer

|

D
10
11
12
13
14

Hame
Equipment

Ma...

Colorl
(-}

-} -

-} -

-} -

-} -

Colarz *

Point cloud included in the layer will be displayed in the specified color.
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il |
D MName Mo... Colorl Colorz #
10 Equipment ¢ I -

1 () - -

12 () - -

13 ¢ - -

14 () - - |
15 G- - '
16 () - -

17 G - - .
18 () - - |

3. Select [Clear Color] in the context menu to clear the color settings of the layer.

Pl |

D MName Mo... Colorl Color2 #
ml__

11 Change Name

12 Set As Target Layer

13 Set As Target Layer for Sh
14

15 Set Color #1

16 Set Color #2

7 Clear Color #1 22

v 18

19 Clear Color #2

A gradation of [Color1] and [Color2] will be displayed when a color is set for
[Color2].

| |

D Mame Mo... Colorl Colorz *
4110 Egquipment - -

(-}
M 11 )
M 12 ()
13 )
14 () - -
M1s )
16 )
& 17 (-)
18 )
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6.4.4. Control Layer Selection
Users can switch whether the layer will be selectable or not for layer editing.

For selected layers, a " v'" mark is displayed in "Pickable" cell. For layers without " v'" mark
including the point cloud, you cannot select the point cloud on "3D View" window.

1. Right-click on the layer you want to remove from selection, then click [Clear Selectable] in
the context menu.

Layer H
Pl |
D Mame Mo... Colorl Color2 ™
%} 10 | Equipment | () | |

11 Change Mame

12 Set As Target Layer

w13

14 Set As Target Layer for Shift Key
15 Set Color #1

16 Set Color #2

17

18 Clear Color #1 #2

19 Clear Color#2

£
— Set Selectable
Show/Hide Clear Selectable
Selectable Generate Polygon from Point Clou

The "v'" mark in "Pickable" column of [Layer] panel will be hidden. Point clouds included in
layers with " v'" mark hidden in "Pickable" column will not be affected by any operations on
"3D View" window.

Layer H
P |
Mame Mo... Colorl Color2 Pickable

G- -
O- -
O- -

Equipment -} - - E
v
v
v

Users can also left-click on [Pick] column " v " to toggle the cell On / Off. If
you click [All Show] in "Selectable”, " v'" will be displayed on all layers. Also,
if you click [Invert Show], you can invert the On / Off status of "v'" .

Q Mo O- B
£

Show/Hide WaLL v

Selectable AL Ll
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7. Generating/Exporting Polygons

7.1. Generating Polygons from Point Clouds in a
Specific Layer

Generate a polygon data from point cloud data imported into InfiPoints.

7.1.1. Run from Ribbon Menu

1. Select [Generate Polygon] (

) in the [Pre-process] tab.

~ 90
—

.

Background Point Cloud with Complement

Point Cloud =
Optimize

2. "Generate Polygon" dialog will appear.

Scan Index -

Point Cloud =

—
Enable || Generate
Layer Edif§ Polygon

Layer

Generate Polygon

1. Select layer(s) to generate polygons from in [Layer] panel.
To multi-select: Select while pressing [Shift] or [Ctrl] key
Selected layer(z) will be highlighted in blue/grey in [Layer] panel.

2. Select how you would like to generate polygons;

(®) Create smoothsimple outline ignoring the noise

() Preserve the details

Cancel

Select the layer to translate into polygon data in [Layer] panel.

Layer % |
Pl |
D Name Mo. of points  Colorl ™

-

i1 —

12

13

14

15 v

L4 >
Show/Hide VhLL v
Selectable “IALL o

Q Multiple layers can be selected by holding down [Shift] key or [Ctrl] key.
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3. Specify the method to generate a polygon. Select "Create smooth / simple outline ignoring
the noise", and click [OK].

Generate Polygon

1. Select layer(z) to generate polygons from in [Layer] panel.
To multi-select: Select while pressing [Shift] or [Cirl] key
Selected layer(s) will be highlighted in bluefarey in [Layer] panel.

2. Select how you would like to generate polygons;

(®) Create smooth/simple outline ignoring the noise

() Preserve the details

Cancel

4. "Generate Polygon" dialog will appear. Adjust "Mesh fineness" and "Trimming area", and
then click [OK].

Generate Polygon X

Mesh fineness

Coarse Fine

Trimming area

Small Large

Create a single polygon model from
multiple point cloud parts

O Create a single polygon model from
multiple yers

["]Color polygons with point colors

oK Cancel

- Enable "Create a single polygon model from multiple point cloud parts"
to create a single merged polygon model from the point cloud parts.
Q When disabled, a polygon is generated per point cloud part.

- Enable "Create a single polygon model from multiple layers" to create a
single merged polygon model. When disabled, a polygon model is
generated per layer.

5. The process of generating polygons will start.
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Generate Polygon *

Generating palygon. . 52% completed

o

After completing the process, a newly generated polygon is added to [Tree (Overview)]
panel.

Overview Pipe Plane Structure Duct

=15 Model

-] Scans

=@ Group?

- 2015021741
-[Aif, 20150217A-2
-5 20150217A-3
-[As 2015021744
-5 20150217A-5
A 20150217A-6
- 2015021747
[ @ Extracted Planes
[1@ Extracted Piping System
% Filtered points

H1:48 Equipment0

7.1.2. Run from Context Menu of [Layer] Panel

1. Select [Show/Hide Panels] ( -i_E"_ ) in the [Home] tab and display the [Layer] panel.

— O d
= - |
50 <5 [[E
— -
Create  Edit Show / Hide
Zone~ Zone Panels =
Zone Tree
Annotation
' | Dimension
| v Layer
Background Paint Cloud

2. Right-click the selected layer to translate into polygon data. Select "Preserve the details"
from the context menu.
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Layer

A

1D Name

Mo. of points  C... C. *

Ma - -
Equipment0l I e

11 Change Name

12 Set As Target Layer

13 Set As Target Layer for Shift Key

[ 1a

< Set Color #1

Show/Hide Set Color #2
Clear Color #1 #2

Selectable Clear Color £2
Set Selectable
Clear Selectable
Generate Polygon from Point Cloud » Smoothly ignoring the noise..,
Copy to new point cloud I e e e I
Calculate Area Projected on Horizontal Plane

Q Multiple layers can be selected by holding down [Shift] key or [Ctrl] key.

3. "Generate Polygon" dialog will appear. Adjust "Max. allowed gap between polygon and point
cloud" and "The Number of Polygons". Click [OK].

Generate Polygon

Max. allowed gap between polygon and point cloud

The Mumber of Polygons

small I large

[ color polygons with point colors

[ Give the maximum edge length for generated polygons 10 m
Create a single polygon model from multiple point cloud parts

[ create a single polygon model from multiple layers

0K Cancel

> By reducing the value of "Max. allowed gap between polygon and point
cloud", finer polygons are generated. Note that the polygon face may
0 not be filled correctly when the value is too small.

o If the polygons are not generated in the intended shape, adjust the
setting and run the polygon generation command again.

- Enable "Create a single polygon model from multiple point cloud parts”
to create a single merged polygon model from the point cloud parts.
Q When disabled, a polygon model is generated per point cloud part.

- Enable "Create a single polygon model from multiple layers" to create a
single merged polygon model. When disabled, a polygon model is
generated per layer.
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4. The process of generating polygon will start.

Generate Polygon ot

Generating palygon. . 52% completed

After completing the process, a newly generated polygon is added to [Tree (Overview)]
panel.

Owverview  Pipe  Plane  Structure  Duct

-5 Model

-] Scans

-9 Groupt

A 2015021741
[ 2015021742
e 2015021743
- 20150217A-4

- [idg 20150217A-5
A 201502174-8
ey 2015021747
-.[/|@F Extracted Planes
-[A@ Extracted Piping System
. [As% Filtered points

A1 Equipment0l
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7.2. Exporting Generated Polygon Data

Generated polygons can be exported to a variety of formats.
Operation differs between exporting as DWG/DXF formats and exporting as STL/OBJ/VRML

formats.

7.2.1. Exporting DWG/DXF files

1. Select the polygon element to translate into polygon data from the structure tree of [Tree
(Overview)] panel. Right-click on the element, and select [Export Drawing] from the context

menu.

Tree

Cverview  pj

pe Plane Structure Duct

=3 Mo
=3
=1

£
e

:

del
Scans

23 Groupl
s 1507364,

Fit View to Model size

-, 1507364,
-, 1507364,
- LS0T364.
- LS0T364.

Edit name

¥ LS07364_ Reset Rotation

Show/Hide part

?&; LS07364 Hide unselected parts

g}%‘; LS07364 -
17 Extractec Export Drawing...
[ [ Extractec Delete

ered points

Reverse Poelygon Qrientation

o The above menu might not be shown when the Clipping Box creation,

¢

dimension measurement, or other certain process is running.

o In that case, finish the process before the export.

2. The following dialog will appear. Click [OK].

InfiPoints

Backgrou

Mode, Would you like to continue?

nd image will not be saved if you are not in Drawing

Cancel

3. "Save As" dialog will appear.

Select the type of file to save, specify the filename and where to save, and then click [Save].
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P Save As X
Savein: | Sample v| (€} b
l MNarme Date modifi.. Type Size

Mo items match your search,
Quuick access

Desktop

This PC

Metwork
File name: Tank dwg w | | Save I
Save as type: Drawing File (" dwa) Cancel

Drawing File (*.dwg)

DXF File (*.dxf) Option

[15avePath

7.2.2. Exporting STL/OBJ/VRML file

1. Select [Output Creation] tab > [Export] > [Polygon Model] ( @ ) from the Ribbon menu.

> & T

Start Video | High Resolution Project Viewe
Creation Image File File =

Video Data Export

. B

2. "Export" dialog will appear.
Select the file type (STL/OBJ/VRML), specify the location to save the file and the filename,
and then click [Save].

Polygon Model I

CG Model
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&P Export ht
Savein: | Sample ~ | @ ? = '
* MName Date modified Type
Mo items match your search,
Quick access
Desktop
This PC
™ >
MNetwork
" File name: FARO_LS07364_020_out v [ sae |
Sawe as type: STL File {Ascii) (" stl) Cancel
STL File (Ascii) (".st) )
STL File (Binary) {*.stl} Options
OB File (*.obj)
WRML File (*wrl,” wrz.” vrml) [~] Save Path

If multiple polygon elements are included in the project file, all polygon
elements will be exported.

Go to [Option] for detailed settings.

Import/Export Settings *
ExEort STL File I
Expert Common Unit System Meter [m] -
Export Format [CJExport each polygon model as a separate file
Import/Export Settings it
Export STL File Export Target Only Displayed Elements
.
Q Assembly [JExport all Brep elements as a single part
Fiping [JExport each Fiping Group separately
[ Export piping elements in displayed colors
[ As solid model
Flane [Export planes in displayed colors
Structure [CJExport structure in displayed colors
Duct [Expart each Duct Group separately
[Export duct elements in displayed colors
[ A= solid model
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8. Measuring

8.1. Measuring Volume and Surface Area

Measure the volume, surface area, and base area within the specified range.

1. Select [Home] tab > [Measure] > [Measure Volume] ( |{%# ).

= 4 D L =

4 Measure Angle

Create Edit Create  Edit Create  Edit Show / Hide
Dimension Dimension Mote= MNote Zone~ Zone Panels =
Measure Mote Zone

2. Pick to enclose the area you want to measure on "3D View" window, and then press [Done] (
D)

Select 3 or more points to specify the zegion by free-form selection. Click [Pone], and the

3. The setting dialog will appear. To specify the location of the ground which will be the basis
of measurement, select | I 'at the right side of "Ground level".

Settings on volume measurement et

Ground level 0.10265207 o, [%

Use auto-detected highest level

0.5993794 [;5

Generate polygon for target reagion

Polygon accuracy

Specify a point at the base ground position on "3D View" window.
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Point Cloud Ver

The Z coordinate value of the picked point is automatically set as "Ground level".

Settings on volume measurement >

Ground level 01026520 o | 3|

[+] use auto-detected highest level

4. Adjust "Polygon accuracy", and click [Execute].

[+] Generate polygon for target region

Polygon accuracy

Rough I Fine

Q When the polygon model is not to be left after measurement is performed,
disable "Generate polygon for target region".

5. Aresult dialog will appear. Confirm the volume, surface area, and base area.

Calculation result *

Volume: 0.00775 m3
Surface Area: 0.35622 m2
Base Area: 0.03946 m2

A polygon model (white) wil be shown for the specified
target region. Click [Edit] to modify the settings to adjust the
target region.

[~] Copy result to clipboard

[ Fnsh || Ea |

6. A polygon model is temporarily created on "3D View" window.
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7. Click [Yes] in the result dialog to save the polygon model.

Tree ﬂ

Owerview  Pipe  Plane  Structure  Duct

=15 Model
56 Scans
5.4 Groupt
[ LS07364_020
o L307364_021

-7 LS07364_027
[ Extracted Planes
[/ [ _Extracted Piping System

lﬂ Measure Volume

When enabling "Copy result to clipboard”, you can paste the measurement result to
Notepad, etc.

Mew Text Docurmnent.bd - Notepad

File Edit Format View Help
Volume: @.88775 m3
Surface Area: 8.35622 m2
Base Area: ©.83946 m2
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8.2. Measuring the Side Volume

As shown in the figure below, this function measures the volume, surface area, and base area of
a region extruded from a specified range to a specified section.

] Sectlon ;

1. On "3D View" window, set the section. Please refer to 1.2, “Using Section View” for details on
how to set the section.

[u]]-] 4l%]2] [o]l5

Hide points outside sectinnF Section Mode

Display the section lUse Curve
Highlight points Auto-align to Z-axis
Display area

®pPsside O Minusside (O With thickness

Thickness | 0.1 =
Move

- - pitch | 0.1 =
N

2. Select [Home] tab > [Measure] > [Measure Volume] ( ||%# ).

- O X
Measure Volume F
= o] 5 4 505 g
2 Measure Angle
Create Edit Create  Edit Create Edit Show / Hide
Dimension Dimension Mote~ MNote Zone~ Zone Fanels ~
Measure Mote Zone

3. Pick to enclose the area you want to measure on "3D View" window, and then press [Done] (

/P
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4. "Setting on volume measurement" dialog will appear. Enable "Use section as the surface
level".

Settings on velurne measurement >

Surface level 0.0072322 . | |3

LUse section as the surface level

Highest level

Adjust "Polygon accuracy", and click [Execute].

Generate polygon for target region

Paolygon accuracy

Rough I Fine

Q When the polygon model is not to be left after measurement is performed,
disable "Generate polygon for target region".
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Please note that if the orientation of the section is incorrect, the following
dialog will appear. In [Section] panel, press [Switch the Orientation
(Plus/Minus) of Section] ( /I|)\ ) to flip the orientation of the section, and
then click [Execute] again.

g InfiPoints =

Cannot run the requested command because the specified
! surface level is invalid.

Please ensure that the specified region exists above the

surface level,

5. Aresult dialog will appear. Confirm the volume, surface area, and base area.

Calculation result *

Volume: 0.38272 m3
Surface Area: 0.38603 m2
Base Area: 0.23791 m2

A polygon model (white) wil be shown for the specified
target region. Click [Edit] to modify the settings to adjust the
target region.

Copy result to clipboard

A polygon model is temporarily created on "3D View" window.

6. Click [Finish] in the result dialog to save the polygon model.
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Tree
Ovenview Pipe Plane Structure Duct

=& Model

5 0 Scans
-7 Groupt
:;; Filtered_points

4% Measure Volume

2 ELYSIUM © 2023 Elysium

Page 100 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

8.3. Measuring Angle

Specify a plane, a straight pipe, or three points on "3D View" window, and measure the angle
between the same type elements.

1. Select [Home] tab > [Measure] > [Measure Angle] (ﬁ ).

- O X

iy | | mem=— oo |
; % % Measure Volume El Ig 07 3 é
& Measure Angle - .
Create Edit Create  Edit Create  Edit Show / Hide

Dimension Dimension Mote~ MNote Zone~ Zone Fanels =

0 Messuwe Mot Zone

2. Specify the target elements (plane, pipe, or among 3 points) on "3D View" window.
To measure the angle of pipes, select two pipe elements (straight pipes) on "3D View
window.

"

"Measure Angle" dialog and a preview of the measured position will appear on "3D View"

window.
In "Measure Angle" dialog, you can confirm the angle and the deviation of the axes of the

two straight pipes.
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Measure Angle

The angle is 89.211 degrees.
The straight pipe axis is 0.595 m distant from the other.

3. To measure the angle of a plane, select two of the same type element from either a plane
element, CAD modeling face (plane), or a structural face on "3D View" window.

117
L0000, 1.0000}

"Measure Angle" dialog and a preview of the measured position will appear on "3D View"
window.

Measure Angle

The angle is 89.532 degrees.
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4. To measure the angle among 3 points, select any 3 points among the cloud vertices and
reference points on "3D View" window.

With a straight line, connect #1 and #2 point, then #2 and #3. Measure the created angle
between these two straight lines. "Measure Angle" dialog and a preview of the measured
position will appear on "3D View" window.

9 Measure Angle

The angle is 67.369 degrees.
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9. Setting Dimensions & Notes

9.1. Setting Dimension

Users can virtually measure dimensions using point cloud data without going on-site.

Therefore, taking measurements of unsafe locations and heights will not be a problem using
InfiPoints.

9.1.1. Creating Dimension

1. Select [Home] tab > [Create Dimension] ( I—T—‘ ) from the Ribbon menu

- O x

Recent

F: };‘é |% Measure Volume IE‘ L?_ﬂ —h (é.} r;

il Measure Angle

Create Edit Create  Edit Create  Edit Show / Hide
Dimension Dimension Mote~ Mote Zone~ Zone Panels -
Measure Maote Zone

2. [Option] panel will appear. In this case, select "Shortest Distance".

Option x|
ﬁﬂ- Option

Direction

Shortest Distance

Horizontal Direction
Horizontal Direction (Area Restricted)
¥ Direction

' Direction

Z Direction

LilElevation and Horizontal

All X7 Directions

(J Use Cylindrical Surface

Please note that if "Section Mode" is enabled in [Section] panel, the
following "Option" dialog will appear.

Option
0 .a.-l} Option

Direction

Shortest Distance of Section
Shortest Distance of Section
Harizontal Direction of Section
Vertical Direction of Section

Restrict the selectable area
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3. Pick the starting and ending point of measurement.

If pipes/planes are already extracted, candidates near the mouse cursor
will be highlighted.

Users can use the [Smart Filter] to select certain elements such as
pipes/planes.

| 43 o= ~ [smart Filter [-] FmfiPoints-
Home Impor Smart Filter

Edge

Polygon Face

Polygon Vertex

Point Cloud Vertex

CAD model face

Reference point

Piping Element / Plane / Duct Element
Structure surface

Structure

Zone

It is not possible to specify 2D drawing elements as selection targets;

Q however, if you generate point clouds from 2D drawings, you can specify
them as selection targets (point cloud vertices). Please refer to "Generating
point cloud from 2D drawing" for details about generating point cloud from
drawing.
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4. The dimension will appear when the starting and ending points are selected.
Users can choose where to locate the dimension annotation when clicking in a selected area.

9.1.2. Creating Dimension (Section Mode)

Users can measure as if on a 2D drawing when viewed from a selected section.

1. In [Section] panel, press [Switch Mode: Clipping/Section] (|% |) to enable the Section mode.

LIIEY

[ Hide points outside section [] Section Mode
[] Display the section Use Curve

2. Select the direction of section. In this case, select "XY (top)" to set the horizontal section.

[JHide points out HZ(Front) 2
[ Display the sect XZ(Back)
[ Highlight points YZ(Right) Z-axis
Display area VZ(Left)
I Plus side ! —zFE
XV(Bottom) Z|

3. Select the location for cross-section in the 3D View Window. A cross-section which passes
through the selected point will be created.
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4. In [Section] panel, enable "Section Mode".

=
Hide points outside sectio
Display the section Use Curve
Highlight points Auto-align to Z-axis
5. Select [Home] tab > [Create Dimension] ( I:-‘ ) from the Ribbon menu to measure a certain

location.

— O X
Recent

; | | o e |
% Measure Volume Ig_l @ [ T =
il Measure Angle nd

Create  Edit Create  Edit Show / Hide

| Mote~ MNote Zone~ Zone Panels -
I | Mote | Zone | |

| Bxport | | vaw || Vo |

0 Show MName Value  Category
11  Dimension(Userl)  1.575m Common

12 Dimension{User2) 0.166m Common
¥/l 2 Dimension{User3) 0.754m Common
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9.1.3. Editing Selected Dimension

1. Pick the dimension to edit on "3D View" window.
[Dimension] panel will appear, and the dimension you picked will be highlighted.

| Bxport | | vauw || Vo |

A |
Show MName Value Category

1 Dimension{Userl}) 1.575m Common
¥l 2  Dimension(User2) 0.166m Comman

| m Dimension{User3) | 0.754m | Commaon

¥ WA i

Select from options

Done Enter
Cancel Bksp
Cancel All

Abort Esc

wr
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3. "Display Settings of Dimension" dialog will appear. Edit the name and format of the
dimension, and then click [OK].

Display Settings of Dimensicn *
Apply common settings Edit common settings
MName Dimension{User3)
Category Commaon v [

#1element: Point Cloud Vertex  #2 element: Point Cloud Vertex
Direction Horizontal Direction b
Individual settings for currently-selected Dimension

T .
#uset color wle
o 'I.'I..‘.?.

Display background

beficet color :.5:.
A T e T ]

9.1.4. Deleting Selected Dimension

1. Select note(s) and dimension(s) to delete in 3D View Window.
[Dimension] panel will appear and selected dimension will be highlighted.

2. Select [Delete the selected elements] ( X ) from the quick access tool bar or select [Delete]
to delete the selected dimension.
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o Other elements may be prioritized for the selection when there are
other elements near the dimension or note to move. Utilize [Smart
Filter] in the toolbar to make only "Note / Dimension" selectable.

W Mote / Dimension ~ #InfiF
Home Import Pre-process Analysis
v Pl (D (@5 e

o Multiple selection is available.

= Select elements while holding down [Ctr]l] key to multiselect.

= Drag the mouse while holding down [Ctrl] key to select by a
rectangular area. (Drag without holding down [Ctrl] key if you are
in "Ortho" mode)

o Another possible way to delete a dimension is to right-click while the
dimension is selected in [Dimension] panel, and then click "Delete”
from the context menu.

WhL Vo
P |

Q Show Name Value Category

10 Dimension({Userd) 1.155m Comman
11  Dimension(Users) 1.138m Cormmon

Edit...

Fit View to Element Size

Show

Hide

I Delete I
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9.2. Setting Notes or Links

Notes (comments) or links to associated files can be created.
Information necessary for construction can be shared using InfiPoints.

9.2.1. Adding Notes

1. Select [Home] tab > [Add Notes] ( [EI ) from the ribbon menu.

- a X

B EEN=

Edit Create  Edit Show / Hide
Mote Zone~ Zone Panels ~

% Measure Violume

{4 Measure Angle
Create
MNote -

ure I Add Notes k
Top Viel || Insert Hyperlinks LR x |
- 4 Attach Files

2. Select an element for which you want to add notes on "3D View" Window.

h __‘a—_P oint Clond Vertex

RS \4 _
X U III ',"- 3 2

ﬂ Elements that can have notes added are point cloud, reference point,
polygon, CAD model, and modeling element.

3. A note will be added. Move the mouse cursor to the preferred position on "3D View"
window, and then left-click.
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4. "Edit Note" dialog will appear. Enter the necessary information, and click [OK].

Edit Mote X
MHame | Uszerl
Mote (-1.158 m, -1.259 m, -0.882 m)
World Axis
Category | Common v|
Display Settings
External Reference
(®) None
() Hyperlink
() Attachment

Browse...

oK

Cancel

¥ ELYSIUM © 2023 Elysium

Page 112 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

Background or text color of notes can be changed from [Display Settings] of
the category.

|87 Display Settings of Note >

Symbaol |(N°”E) i |
] Apply common settings Edit common settings

Individual settings for currently-selected Note

Display text
Font Color Set color

Q Font Size
(®) Show in fixed font size D pt

() Show in actual size 0.05 m
[[]5how a box at Mote location

Display background

Background color

—_— omp

LeaderWitness color Set color
Leader/Witness line weight pt

- An example of notes setting change (color)

s Shi
mstruction Manual (PDF)
b -
fWeb page for reference
= | M i
.H. P ' . . [
Gaution points in construction

afy
|’

Gaution points ir
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It is possible to change the setting for all notes. Select [Application
Menu] > [Option] > [Display Settings] > [Annotation].

Display Setting
Light Display text
TESSE-”EtIDI"I Tel Fort Color Set color
Drawing
Annotation Font Size
Dimension (®) Show infixed font size pt
Deviation (O Show in actual size 005 T
Point Cloud
Plane/Piping Element Leader/\Witness color Set color
CAD/Polygon Model Leader/Witness line wei 033

ght : pt

Q Reference Point -

[] Show a box at Mote location
Display backaround
Backaround color
Opacity
Display postion
(®) Fix at a specified position
() Auto
Dizplay height

5

E ]

L
.2

m

Always show a waming message when opening extemnal links

Hide Motes placed away from the viewpaint

Display range m

9.2.2. Editing Notes

1. Select [Home] tab > [Edit Note] ( ) from the Ribbon menu.

% Measure Volume B [
- BIE]| 5 <> &
&l Measure Angle - .
Createl| Edit Create  Edit Show / Hide
Mote~ll| Mote Zone~ fone Panels =

ure MNote Zone

2. Pick the note you want to edit on "3D View" window to display the "Edit Note" dialog. Select
[Display Settings] in the dialog.
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Edit Mote *
Mame Userl
Mote Caution points in constructinn|
Category |C0mmnn v| V4

| Display Settings

External Reference

(®) None

() Hyperlink

(O Attachment Browse. ..

Gancl

3. "Display Settings of Note" dialog will appear.

Disable "Apply common settings" to allow editing the individual settings. Change the display
settings such as font color and background color, and click [OK].

i " Display Settings of Note *

Symbal (None) w

[] apply common settings Edit common settings

Individual settings for currently-selected Note

Display text

Font Colar Set color

Font Size
(®) show in fixed font size pt
() Show in actual size 0.05 i

[ ]5how a box at Note location

[+“] Display background
Badkground color Set color
Opadity %
Leader/Witness color Set color
Leader Witness line weight 0,33 pt
cance
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10. Extract Text

Please ensure to "Log In" to InfiPoints Cloud from [System Settings] > [Cloud
Function] tab before using the function [Extract Text].

System Settings

Path
Quick Accese Toolbar Click here for details about Cloud Function. {Requires the intemet connection.)

BackGround Color
Axis InfiPairts Cloud account information

Ground plane

Ruler/Grid

Rotation Center Email | |
Wiew operation

Wiew operation(2) Password | |

CAD/Polygon Model
Cloud Function
Miscellaneous

Enable autodogin when launching InfiPoints

Log In Log Out Logged in as oda

10.1. Extracting Text

This function auto-detects text strings from point cloud with scan index and extracts them as
text.

1. Select [Pre-process] tab > [Extract Text] ( “A ) from the ribbon menu.

Pre-process Analysis Modeling Cutput Creation Recent Help
| . - &g P - LY o — F 1
nal Refergnce Points r::q}r !. Color/Intensity Filte C\A I:’Ll{.] ﬂ .ﬂ Edi
o Groups ek } s — De
Remove Extract || Extract Planes Create
teference Points Maise = ‘] Extract Pole Text and Pipes -
Filter Extract Primitive Texture

2. When "Extract Text" dialog appears, select the preferred options, and click [OK]. Text
extraction will begin.

Extract Text >

Extract using Colar [Jintensity

Cancel

3. After text extraction is completed, click [OK] in the dialog.

Extract Text X

The process has been completed.

Cancel oK
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The extracted texts will be displayed in [Text Extraction Result] panel.

) oo

b~ 0~ 2 Y v

Text Extraction Result

MName T Text

0 [ali B 25
1 5
2 BR
3 300
4 Shn
Property
M/A

Please refer to InfiPoints Help [Function Overview] > [User Interface] >
[Text Extraction Result Panel] for more details about the commands in
[Text Extraction Result] panel.
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11. Detecting Collisions

11.1. Importing CAD Data

Import CAD data and/or polygon data into InfiPoints and view them with the point cloud data. A
newly to-be-installed equipment can be imported to examine the after-construction state, for

example.

1. Select [Import] tab > [CAD Model] ( ) from the Ribbon menu.

| o
Home

- = Note /Dimension ~*  FInfiPc
P—
Import Pre-process Analysis

% =L Merge Project Files

Cloud Model Drawing
Data Import
Q Select [Data Import] tab > [Polygon Model] ( -}. ) to import a polygon
model.

2. Specify a CAD model and click [Open].

& Import bt
Look in: | sample V| @‘ 1} = '
* MNarme - Date modified Type
rD zamplel.model 2/4/201510:42 PM MODEL File I
Quick access
Desktop
m
Libraries
This PC
y H < >
- File name: sample1.model I Open
MNetwiark
Files of type: CATIA V4 File (*model,” catdata,” catexp) ~ Cancel
Options
Save Path
Q Users can also drag-and-drop the model for import.

3. "Position of the Model" dialog will appear. Specify the method of placement and click [OK].
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Positien of the Model *

(®) At the center of the current view
(") At the absolute coordinate of the model
() At a spedified position (point / reference point)

Place perpendicular to the estimated normal of adjacent points

Cancel
At the center of the Places at the center of "3D View" window.
current view
At the absolute Used when the point cloud and model are on the

coordinate of the model | same coordinate system

At a specified position Select a point in the 3D View Window to place the
(point/reference point) model
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11.2. Generating CAD Models from Modeling
Elements

This chapter explains the procedure to generate CAD models from modeling elements to
conduct collision detection in Elysium InfiPoints.

0 To export modeling elements in CAD formats, you do not need to generate CAD
models in Elysium InfiPoints beforehand.

11.2.1. Generating CAD Models from Piping Elements/Groups

1. Select [Analysis] > [Generate CAD] > [From Piping Element/Group] ( IEE ).

| % % ¥ = |Smart Filter - EInfiPoints
Home Import Pre-process Analysis
P—
el 99 &5 X,
wlj } téﬁ (ll*— I:]_-J ﬁ._v\.l
CAD  Polygorg|Generate Move Fitto Point Detect Collisi
Model Model} CAD~ w Cloud Mode~

Import T From Piping Element/Group

Tree !]}' From Structure Element/Group
Overview Pipe 42 From Plane Group

=-i]& Mode = From Duct Element/Group
E-BAC3 Scans

2. Check "Convert to solid model" in [Option] panel.

Option
ﬁ'ﬂ' Options

Convert to solid model

* Chedk this option to use the generated
CAD maodel for collision detection,

[]use display colors

Check "Use display colors" option in [Option] panel to generate CAD models

using the display colors of the source piping element(s)/group(s) in "3D
View" window.

3. Select piping element(s) and/or piping group(s) to generate a CAD model from, and click
[Done] ( 0 ).
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Edit the piping Tree as required prior to the CAD model generation. Please
€  refer to [Pipe Modeling] > [Editing Piping Tree] in [Elysium InfiPoints
Operation Manual Vol.3 Point Cloud Utilization: Modeling for the details.

o Select while holding down [Ctr]] key to multi-select.

o Change the [Smart Filter] to [Piping Element / Plane / Duct Element] or
[Piping Group / Plane Group / Duct Group] to filter the selectable

Q categories.
| 0 W % < Piping EIementfPIB I;Flnfl'l?’c:l-ims-
Home Impor Smart Filter
- | Piping Element / Plane / Duct Element
@
ﬁ I& Piping Group / Plane Group / Duct Group

CAD model(s) will be generated from the selected piping element/group(s). (Image below:
The CAD model is shown in [Semitransparent])

The CAD model(s) will be added to [Tree (Overview)] panel as
"Created_Piping_Element"/"Created_Piping_Group".
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Tree

Structure  Duct

Cwerview  Pipe  Plane

=- & Model
5.0 Scans
523 Groupt
[ 20150217A-1
[ 20150217A-2
s 20150217A-3
E Extracted Planes
L. Extracted Piping System
M1 Created_Piping_Group

11.2.2. Generating CAD Models from Structure Elements/Groups

1. Select [Analysis] tab > [Generate CAD] > [From Structure Element/Group] ( @ﬁ' ).

3 x Smart Filter *  FinfiPoints
Home Import Pre-process Analysis
W P (E3 @B @
CAI; Polygor) Generate Move Fitto Point | Detect Collisi
Model Modell| CAD~ v Cloud Mode~
Impart 'S.  From Piping Element/Group
Tree #y  From Structure Element/Group
Overniew  Pipe w7 From Plane Group
=-f/lE Mode| < From Duct Element/Group
5[ Scans

2. Select structure element(s) or structure group(s) to generate CAD model(s) from, and click

[Done] (@).
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Edit the tree structure as required prior to the CAD model generation.

0 Please refer to [Structure Modeling] > [Editing Tree (Structure)] in [Elysium
InfiPoints Operation Manual Vol.3 Point Cloud Utilization: Modeling for the
details.

o Select while holding down [Ctrl] key to multi-select.

o Change the [Smart Filter] to [Structure] or [Structural Group] to filter
the selectable categories.

=y ~ |Structure * |  FInfiPoi
Home Impor _>mart Filter is
— Structure
_.. . Structural Group
Extract Planes Create on Create at Adl

and Pipes Specified Planes Specified Point Structure

Q o Check "Use display colors" option in [Option] panel to generate CAD
models using the display colors of the source structure element
(s)/group(s) in "3D View" window.

Option x|

ﬁﬂ' Options

Use display colors

CAD model(s) will be generated from the selected structure element/group(s). (Image below:
The CAD model is shown in [Semitransparent])

The CAD model(s) will be added to [Tree (Overview)] panel as
"Created_Structural_Element"/"Created_Structural_Group".
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Tree

Cwerview  Pipe

(= = Maodel
|_:_||:| Scans
w100 Group?

.:"__.f' Extracted Planes

Structure
= Created_Structural_Group I

Plane Structure Duct

11.2.3. Generating CAD Models from Plane Groups

1. Select [Analysis] tab > [Generate CAD] > [From Plane Group] ( .:7,‘ )

Yy N Smart Filter - EInfiPoints
Home Import

Pre-process Analysis |

- b S s *.

LWLy 3 b a I

LA (oA P eI b

CAD  Polygor]|Generate Move Fitto Point Detect Collisi

Model Modelf CAD~ w Cloud Mode
Import

‘5.; From Piping Element/Group
Tree g.lx

e

rom Structure Element/Group

Overview Pipell <2 From Plane Group

=& Mode = From Duct Element/Group
= Scans

2. Select plane group(s) to generate a CAD model from, and click [Done] ( Q ).

Edit the Plane Tree as required prior to the CAD model generation. Please
ﬂ refer to [Plane Modeling] > [Editing Plane Tree] in [Elysium InfiPoints

Operation Manual Vol.3 Point Cloud Utilization: Modeling for the details.
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o Select while holding down [Ctrl] key to multi-select.

> Check "Use display colors” option in [Option] panel to generate CAD
models using the display colors of the source plane group(s) in "3D
View" window.

Q Option % |
‘n'n Options

|Jse display colors

CAD model(s) will be generated from the selected plane group(s). (Image below: The CAD
model is shown in [Semitransparent])

—

The CAD model(s) will be added to [Tree (Overview)] panel as "Created_Plane_Group".

Tree x|
Owverview Pipe  Plane  Structure  Duct
=-;/& Model

=3 Scans

-3 Point cloud
5.3 Piping and Plane
E Extracted Planes
] Extracted Piping Systemn
MA@ Created_Plane_Group

11.2.4. Generate CAD Model from Duct Elements/Groups

1. Select [Analysis] tab > [Generate CAD] > [From Duct Element/Group] ( NE ).
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| # % ¥ % |Smart Filter = EInfiPoints
Home Import Pre-process

Analysis |

el il - 7
W R = | &3 N4
CAD  Polygor]|Generate Move Fitto Point
Model Modelf CAD~ E

Detect Collisi
Cloud Mode~

W Et; From Piping Element/Group

Tree !;:'. From Structure Element/Group l

Oveniew  Pipe -

rom Plane Group

=& Mode W From Duct Element/Group
=-I13 Scans

2. Check "Convert to solid model" option in [Option] panel.

Option
¢'¢_ Options

Convert to solid model

* Check this option to use the generated
CAD model for collision detection,

[]use display colors

Check "Use display colors" option in [Option] panel to generate CAD models

using the display colors of the source duct element(s)/group(s) in "3D View"
window.

3. Select duct element(s) and/or duct group(s) to generate a CAD model from, and click [Done] (
/D

Edit the duct Tree as required prior to the CAD model generation. Please
refer to [Duct Modeling] > [Editing Duct Tree] in [Elysium InfiPoints
Operation Manual Vol.3 Point Cloud Utilization: Modeling for the details.
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o Select while holding down [Ctrl] key to multi-select.

o Change the [Smart Filter] to [Piping Element / Plane / Duct Element] or
[Piping Group / Plane Group / Duct Group] to filter the selectable

Q categories.

[ #9 % 3 +% ~|piping Element /P1|~|  FInfiPoints -
Home Impor, Smart Filter
- | Fiping Element / Plane / Duct Element
@
ﬁ | k Fiping Group / Plane Group / Duct Group

CAD model(s) will be generated from the selected duct element/group(s). (Image below: The
CAD model is shown in [Semitransparent])

The CAD(s) model will be added to [Tree (Overview)] panel as
"Created_Duct_Element"/"Created_Duct_Group".

Cwerview  Pipe  Plane  Structure  Duct

=-E Model

=-M3 Scans

- Groupl

.[Flc7 Extracted Planes

~plEgd Duct System
; 2 Created_Duct_Group
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11.3. Detecting Collisions (Manually)

Users can conduct collision check between point cloud data and imported CAD model (or
polygon model). Collision detection can be performed by moving the imported CAD model
inside of the point cloud. This function can be used to check import routes of equipment and
examine a specific location for placement.

A\ About Accuracy of Collision Detection £\

"Collision detection" emphasizes real-time processing, which is more likely to produce
errors than "interference detection". Therefore, depending on the geometry of the CAD
model (or polygon model), collision may be detected even where it did not originally
collide.

For a more accurate interference check, refer to "Detecting Interferences" and it is
recommended that you confirm visually.

1. Import a model to check against collision.

Q Please refer to 11.1, “Importing CAD Data” for details about importing
models.

2. Select [Analysis] tab > [Detect Collision Mode] > [Detect Collision: ON (Shown Points only)]
( a! ) from the Ribbon menu.

~ Smart Filter v FInfiPoints
Home Import Pre-process I Analysis deling Output Creation
: 99 &7 Al [
1 | i . o l"‘w. o é

Import Move Fit to Point | § Detect Collision Detect Start CAD
CAD/Polygon Model £l Cloud Mode - nterference Validation
Impart Move Validate
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To make a hidden point cloud part in [Tree] panel the subject of collision
check, select [Analysis] tab > [Detect Collision Mode] > [Detect Collision: ON
(Including Hidden Points)] ( :# ).

An error message as below will appear if the view mode is changed in layer settings.

InfiPoints X

| You have to regenerate data for collision detection

' Users can disregard the message and detect collisions, but the screen view
— may not be accurately reflected.

Select [Analysis] tab > [Detect Collision Mode] > [Regenerate Data for
Collision Detection] ( C. ) to reflect the current view mode.

| = * = Wote/Dimension = FInfiPoints -

ﬂ Home Import Pre-process = Output Creation
nl 93 R o 2
-}_ p (227 A pa é

Import Move Fit to Point  |Detect Collision| Detect Start CAD
CAD/Polygon Maodel & Cloud Mode~ Interferench Validation

Impart Move ‘@ Detect Collision: ON (§hown Points Only)

®  Detect Collision: ON (fhcluding Hidden Points)
|| Detect Collision: OF

I' Regenerate Data for Collision Detection I

3. Select [Analysis] tab > [Move] ( .5 ) or [Move with Restraints] ( ./ ) from the Ribbon menu
to move the CAD data. Specify the model.

| #3 0% % ¥+ Smart Filter | FInfiPoints
Home Import Pre-process Analysis

Import

it to Point
CAD/Polygon Maodel Cloud Mode~

Detect Collision

In
Impart “3  Move Val
Tree s Maove with Constraint
Overview Pipe Pla = Move to Specified Point

25 Move Freely move the CAD model

{3 Move with Restraints | Offset, move in parallel or rotate the CAD model by

restraining them on a plane or axis

Q Please refer to "5, Move" for moving operation.

4, Move the model in "3D View" window.
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When there is a collision between the CAD model (or the Polygon model) and the
surrounding point cloud, the CAD model (or the Polygon model) is shown in semi-
transparent blue and the collided area (point cloud) in red.
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11.4. Detecting Collision on Path

Users can check for collisions of imported CAD model (or polygon model) and surrounding
point cloud along a predetermined path. The CAD model (or polygon model) movement path
can be saved as a movie for sharing with others.

Move the CAD model along the path to create a point cloud part which is independent from the
point cloud where it collided.

Preparation for Detecting Collision on Path

* When detecting for any collisions on the path, it is required to set the path in advance
using the motion function. Please refer to 14, Creating a Movie for details about

motion function.

» Please ensure that [Detect Collision Mode] is enabled.

| ) h - Smart Filter - ;':InfiPoints
Home Impart Pre-process I Analysis ndeling Cutput Creation
B 99 &x 7 (E
R2 — 259 2 |4 ®
Impaort Maowve Fit to Point | Detect Collision Detect Start CAD
CAD/Polygon Model = Cloud Mode ~ nterference Validation
Import Maove Validate

1. Select [Output Creation] tab > [Start Video Creation] ( EEE‘) ) from the Ribbon menu.

I Output Creation I Recent

2: Diametrfr Dimension

abe Text ,-"h:_; Motes & Dimensions style

>

L Angula

‘ P ‘

®

Start Video,
Creation

Video

o

Upload

Cloud Function

2. [Motion] panel will appear. Select the preferred motions to play, and enable "Save collision
detection result" option.

2 ELYSIUM © 2023 Elysium

Motion % |
Ex... Sh... Motion Name  Start ti...  Play Time
v PlnB_OK 00:00.00  00:09.00

v PlnB_NG 00:00.00  00:09.00
£ >
* |- \‘:) & M| | (vaw| (Ve (B

[]Pause at where it colides

I Save collision detection result
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' Please note that when [Detect Collision: OFF] ( :_g ), you cannot select
—_ "Save collision detection result" option.

3. In [Motion] panel, press [Play] (IEI ).

00:00.00 |+ 00:08.56

Qo

4. A confirmation dialog will appear.
Specify the layer to which you want to copy the point cloud with collisions to, and then click
[OK].

Confirmation *

Do you wish to create a new paint doud file
induding the collision detection result (colliding
points hiohlighted)?

Layer 11 ~

[ o |

5. The process to detect collision points will start. After completing the process, click [OK] in
"Collision Detection" dialog.

Collision Detection x

The process has been completed.

A preview of the CAD model moving along the path with collision detection can be seen.
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In [Tree (Overview)] panel, a new point cloud part (Collision Points) consisting only of
collision points will be created.

Tree E

Cwerview  Pipe  Plane  Structure  Duct

=-b71 8 Model
—|:| Scans
5[ Group?
5-FA23 CAD model
../ EquipmentZ
[s% Collision Points

Stp

Also, the created point cloud part (Collision Points) is copied to the specified layer.

Layer H
P |
ID MName Mo. of points  Colorl *

10  Equipment? - -
11  Coliding Points 840 -
] 12 -
A am
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11.5. Detecting Interferences

Select a desired distance from the imported CAD data (or Polygon data), and detect point clouds
within that area. It is also possible to create a point cloud from the detected points.

1. Import CAD model (or polygon model) for interference check.

Q Please refer to 11.1, “Importing CAD Data” for details on importing models.

2. Select [Analysis] tab > [Detect Interference] ( ) from the ribbon menu.

.|“‘1 ™ % % +|Note/Dimension ~*| FInfiPoints-

Home Import Pre-process Analysis Modeling Qutpu

99 @ % g | F%
¥ SO | &
Impart Move Fitto Point | Detect Collision Detect Start CAD
CAD/Polygon Model = Cloud Mode~ Interference fvValidation
Impart Maove Validate

3. Select the target model in "3D View" window or [Tree (Overview)] panel.

4. The "Interference Detection" dialog will appear. Specify the distance to detect interference
in "Interference Distance" and click [Execute].
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Interference Detection ot

Interference Distance II'
m

Ma. of highlighted points

Low I High

[ advanced settings

Number of points detected within the specified "Interference Distance" from the model’s
face and number of points detected inside the model itself will be displayed in the following

dialog.

InfiPoints

The number of detected points was 2203,

Also, in "3D View" window, interfering points of the point cloud will be highlighted in red.

5. In the dialog where the number of points appear, click [OK].

In the lower left of "Interference

Detection" dialog, [Generate New Point Cloud of Interfering

Points Only (Without scan index)] (| Z; |) will be activated.

-y
—

6. Click [Generate New Point Cloud

of Interfering Points Only (Without scan index)] (| Z5 ) to

generate a point cloud from highlighted points.
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The following dialog will appear, so click [Yes] as is.

InfiPoints

Generating a new point cloud part from the last interference
check result, [Interfering points only / Without scan index)

Click [Yes] to continue.

A red point cloud without scan index data is generated from the red highlighted points on
"3D View" window.

Tree a
Oveniew Pipe Plane Stucture Duct

B--E Muodel
g Scans
=103 CAD model
: I EquipmentZ.stp

ry
S

w Detect interference points EquipmentZ.stp.pocI
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12. Comparing CAD and Point Cloud

Automatically compare differences between scanned point cloud data and designed CAD data.
This functionality can be used to compare plan and construction result, or to track changes
made on facilities over time.

1. Select [Analysis] tab > [Start CAD Validation] ( ' @ ) from the Ribbon menu.

| & “* = |Note /Dimension ~  FinfiPoints -
Home Import Pre-process Analysis Modeling Output

m mifa?
B2 - |20l®
Import Mowve Fitto Point Detect Collision Dete
CAD/Polygon Model v Cloud Mode~ Interference
Import Move Validate

2. [CAD Validation] panel will appear. Press [Add Target Model to the List] (| 4 ) and pick the
target model you want to compare in "3D View" window.

Target Model List

71| | B2 Validate toward | Mearest point ~

Show difference within

|| [ @] 206 | m

Faint size |5

CAD models, polygons, piping elements, piping groups, planes, plane
groups, ducts, duct groups, structures, and structure groups can be
specified for comparison.

3. In [CAD Validation] panel, press [Show Validation Result] (| ££ ).

CAD Validation B

Target Model List
Piping Elements: Straight Pipe [1540]

| o (S Validate toward | Mearest poini ~
st Show difference within
b o | @ 1=-06 m
] 0.1 m
x]

Paint size | 5
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4. A "Show fitting difference" dialog will appear. Click [OK].

Show fitting difference >

Do you want to chedk the fitting difference?

Recalculate fitting difference

ook | Cancel |

Colored points and indicators based on the result of calculated differences will appear in
"3D View" window.

The gradation view result in the main screen can be changed by controlling
the value of the "Show difference within" option in the [CAD Validation]
panel.

Target Model List
PFiping Elements: Straight Pipe [1540]

g 3 e Yalidabe koward | Nearest paind
Show difference within
2|9 [ n
| :
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13. Managing 2D Drawings

13.1. Creating 2D Drawings

You can create 2D drawings with InfiPoints. Followings are the instruction on how to create a
2D drawing at the position of the section.

Preparing for Creation of 2D Drawings

» 2D drawing is created at the position specified by the section or Clipping Box.

- Enable the [Section] panel by selecting [Switch Mode: Clipping / Section] (|%* |) if
you want to create 2D drawings by using the section. Also, if you want to create 2D
drawings by using the Clipping Box, enable the [Clipping] panel.

Section |
34| @ |~ 4] %) 2] @5

Hide points outside section (] Section Mode
Display the section Use Curve
Highlight points Auto-align to Z-axis

* Please refer to "Create Section" in "InfiPoints Operation Manual Vol.2
Point Cloud Utilization: Simulation & Data Utilization" for ways to
Q create a section.

* Please refer to "Create Clipping Box" in "InfiPoints Operation Manual
Vol.2 Point Cloud Utilization: Simulation & Data Utilization" for ways
to create a Clipping Box.

' You cannot use [Section] panel and [Clipping] panel at the same time.

1. Select [Output Creation] tab > [2D Drawings] > [Create 2D Drawing] ( [l ) from the Ribbon

menu.
) M - Smart Filter - 7 InfiPoints
Home Import Pre-process Analysis Modeling Qutput Creation
‘ Show Intersection Curves ‘ Line Circle 'J(
S T 'y ik i L TN to Edit Shap
able 2D ‘
Drawing [Drawing Edit Arc

2D 1
O Please enable the [Section] panel when creating the 2D drawing.

2. On "3D View" window, a preview of where the drawing will be created is displayed. In
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"Create Drawing" dialog, click [OK].

Create Drawing *

Click [OK] to create a working plane at the location specified in
[Clipping] / [Section] panel, or [Cancel] to specify a different location.

Gance

Edit Drawing Mode is automatically enabled and 2D drawing which includes intersection
curves with planes and pipes is created at the position where the section was created.

A [Drawing] folder will be added to the [Tree (Overview)] panel.

Tree A
Overview Pipe  Plane  Structure  Duct
=-E Model

EID Scans

- @03 Group
.7 Extracted Planes
. _.[F1[ Extracted Piping System
=l Drawing

----- M drawing3.dwg |:;,r=4 side view)
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13.2. Editing 2D Drawings

The existing 2D drawings can be edited.

13.2.1. Switching to "Edit Drawing" Mode

1. If you would like to edit another drawing ( [ ), right-click on the drawing from the [Tree
(Overview)] panel and select [Target Drawing for Edit].

Tree E
Owverview Pipe  Plane Structure  Duct
=25 Model

- Scans
A3 Groupt
A7 Extracted Planes
[ Extracted Piping System
-3 Drawing
LT drawingl.dwg (y=4 side view)

=000 yv=1.00 z=0.00]

Fit View to Model size

Edit name

Reset Rotation

Show/Hide part
Hide unselected parts

Target Drawing for Edit

Fit section to Drawing

0 Pencil mark ([ ) is placed on the icon of drawing to edit.

R

2. Select [Output Creation] tab > [2D Drawing] > [Enable 2D Drawing Edit] (&3] ) from the
Ribbon menu.

|4 ‘¢ = |smart Filter - FinfiPoints -
Home Import Pre-process Analysis Modeling Cutput Creation

Show Intersection Curves Line Circle = Linear Din
+

E— = = Aligned D

Create 2DJ Enable 2D . ) . _

Drawing ||Drawing Edit  Arc Radial Din

20 Drawing

When you are in the [Edit Drawing Mode], your view will be set as a drawing view and
drawing menus will be enabled. You can also select drawing objects to edit or delete.
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Edit Drawing Mode

13.2.2. Adding Drawing Elements

The drawing elements (Line, Rectangle, Arc, Circle) can be added to the 2D drawings.

EaNe %~ |Smart Filter - EInfiPoints -
Home Import Pre-process Analysis Modeling Qutput Creation

Q' |__ Show Intersection Cunres| /" Line (=) Circle =
+ L:J "
o Update Intersection Curves || [ Rectangle .- Add Vertex to Edit Shape
Create 20| Enable 2D
Drawing |Drawing Edit [ Arc

20 Dra

® By connecting 2 selected points

1. Select [Output Creation] tab > [2D Drawing] > [Line] ( / ) from the ribbon menu.

2. In [Option] panel, select "By connecting 2 selected points".

Option
'¢¢_ Option

How to draw a line

(®) By connecting 2 selected points
() By drawing from #1 paint toward #2 point for specdfied length

Length |1 m

3. On "3D View" window, specify the point to start a line.

I
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4. Specify another point to finish the line on "3D View" window. A line connecting these 2
points will be created.

By holding down [Shift] key and specifying the end point position, you can
create a straight line in parallel or vertical direction.

e.g. Left: without [Shift], Right: with [Shift]

You can continue to create a new straight line from the last selected end point. If you want
to finish adding lines, press [Cancel the selection and quit this function] ( @ ).

In the 2D drawings, yellow marks are displayed as guides at corners,
intersection of lines, the center point of lines, intersecting vertically with
straight lines, and so on.

? o

® By drawing from #1 point toward #2 for specified length

1. Select [Output Creation] tab > [2D Drawing] > [Line] ( / ) from the ribbon menu.

2. In [Option] panel, select "By drawing from #1 point toward #2 point for specified length",
and enter the length of the line you wish to create.

#2 ELYSIUM © 2023 Elysium Page 143 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

.nl-ﬁ- Option

How to draw a line

() By connecting 2 selected points
(®) By drawing from #1 peint toward #2 point for spedified length

3. Select #1 point in "3D View" window to define the start point.

4. Select #2 point in "3D View" window to define the direction.

A straight line from #1 point toward #2 point with specified length will be created.

Continue creating the next line using the specified endpoint as the base point. If you want to
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finish adding lines, press [Cancel the selection and quit this function] ( @ ).

m Creating New Rectangles

1. Select [Output Creation] tab > [2D Drawing] > [Rectangle] ( [1) from the Ribbon menu.

2. Click a point to define a corner of a rectangle on the 3D View Window.

3. Click another point which will become the opposite angle of a rectangle on the 3D View
Window. A rectangle is created that connects two points on a diagonal.

You can continue to creat rectangles. To finish adding rectangles, press [Cancel the selection
and quit this function] ( @ ).

® Creating New Arcs

1. Select [Output Creation] tab > [2D Drawing] > [Arc] ( f ) from the Ribbon menu.

2. Click a point to start an arc on "3D View" window.
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3. Click a passing point on the circumference of the arc.

4. Click another point on the 3D View Window to finish the arc. An arc with these 3 points will
be created.

You can continue creating arcs. To finish adding arcs, press [Cancel the selection and quit
this function] ( O ).

m Creating New Circles

1. Select [Output Creation] tab > [2D Drawing] > [Circle] ( @ ) from the Ribbon menu.

2. Click the center position of the circle on the 3D View Window. The size of the circle changes
according to the movement of the mouse.
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3. Click the point on the circumference. A circle will be created.

You can continue to create circles. To finish adding circles, press [Cancel the selection and
quit this function] ( (€9).

[Circle by 3 Points] ( [:l ) can be created by specifying 3 points on the
circumference.

Q Maodeling Output Creation Recent

/" Line (+] Circlej | Linear Dimfension

[J Rectanglel (&% Circle mension

{ Arc () circle by 3 Points ension

m

13.2.3. Adding Dimensions/Annotations

Dimensions/Annotations can be added to the 2D drawings.

Modeling Cutput Creation Recent
¥ Linear Dimension () Diametric Dimension | abe Text A Motes & Dimensions style
" Aligned Dimension 4 Angular Dimension *= Multiple Leader
) Radial Dimension

rawing

® Creating New Linear Dimensions
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1. Select [Output Creation] tab > [2D Drawing] > [Linear Dimension] ( k- ) from the Ribbon
menu.

2. Click a point to start a line to measure on the 3D View Window.

3. Click another point to finish the line to measure on the 3D View Window. The linear
dimension is displayed.

4. Specify the position where you want to place the dimension line. The dimension line that
indicates the length in the vertical or horizontal direction is created at the specified position.

® Creating New Aligned Dimensions
1. Select [Output Creation] tab > [2D Drawing] > [Aligned Dimension] ( ’(\, ) from the Ribbon
menu.

2. Click a point to start a line to measure on the 3D View Window.
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[T

3. Click another point to finish the line to measure on the 3D View Window. The aligned
dimension is displayed.

4. Specify the position where you want to place the dimension line. The dimension line that
indicates the length in the shortest distance is created at the specified position.

® Creating New Radial Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Radial Dimension] ( ::/;' ) from the Ribbon
menu.

2. Select an arc or a circle to measure the radius on the 3D View Window. The radial
dimension is displayed.

3. Specify the position where you want to place the dimension line. The dimension line that
indicates the radius of the circle is created at the specified position.
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® Creating New Diametric Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Diametric Dimension] ( '3;_’/_%3' ) from the Ribbon
menu.

2. Select an arc or a circle to measure the diameter on the 3D View Window. The diametric
dimension is displayed.

3. Specify the position where you want to place the dimension line. The dimension line that
indicates the diameter of the circle is created at the specified position.

m Creating New Angular Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Angular Dimension] ( 5_ ) from the Ribbon
menu.

2. Pick the two straight lines measuring the angle on the 3D View Window. The angular
dimension is displayed.

3. Specify the position where you want to place the dimension line. The dimension line that
indicates the angle between the two straight lines is created at the specified position.

#2 ELYSIUM © 2023 Elysium Page 150 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

® Adding a New Text

1. Select [Output Creation] tab > [2D Drawing] > [Text] ( abc ) from the Ribbon menu.

2. Left-click the mouse at the position where you want to place the text note on "3D View"
window. "Text" dialog will appear.

Text *
| ]
Gancel
0 The 3D coordinate of the specified position is displayed in the text box.

3. Edit the text box and click [OK] to create the annotation.

Q o You can use control characters, such as \P (line break).

o Added text cannot be edited.

® Adding a Multiple Leader

1. Select [Output Creation] tab > [2D Drawing] > [Multiple Leader] ( ,2% ) from the Ribbon
menu.

2. Click on the position where you want to start the leader line on the 3D View Window.
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3. Move the mouse cursor and then left-click to fix the location of the leader line. The multiple

leader dialog is displayed.

Multiple leader

text

Gancel
0 Please note that the text box displays the 3D coordinates of the position
where the leader line started.

4. Edit the text in "Multiple leader" dialog and click [OK] to add a new leader.

O Added text cannot be edited.

13.2.4. Moving the Drawing Elements / Annotations / Dimensions

1. Pick an element to move on "3D View" window. Selected element is shown in dotted line

with blue grips.

2. Select a grip you would like to move. Selected grip will be shown in red. As the mouse
moves, the shape of the drawing element changes. Left-click on any point to confirm the
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change.

3. Select [ESC] key to confirm all the changes. Edited drawing element will turn back to solid
line.

13.2.5. Deleting the Drawing Elements / Annotations / Dimensions

1. Left-click on an element to delete on the 3D View Window.

0 Multiple drawing elements can be selected at the same time.

2. Select [Delete the selected elements] ( ¥ ) from the quick access tool bar or select [Delete]
to delete the selected drawing elements.
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13.2.6. Changing the Style of the Drawing
Elements/Annotations/Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Notes & Dimensions style] ( A‘:‘; ) from the
Ribbon menu.

2. "Edit Style" dialog will appear. Change the character size, the number of digits after the
decimal point, etc. and click [OK].

Edit Style *
Dimension Multiple leader
Scale factor Scale factor
Text height 0.40m Text height 0.40m
Text weight 25 ~ Text weight 25 ~
Text color Text color
Line weight 25 ~ Line weight 25 ~
Line color Line color
Decimal 1 = T
Dimension extension line Text height m
== il 25 e Text weight 25 ~
Ereek Text color
Angular dimension EerE s
Format Decimal degrees Freosrn 25 -
(and I:U - Line color
Use the spedified line weight in 3D View as well
Cancel

- Please note that by selecting an element in the drawing on "3D View"
window and executing, only the selected element will be subject to
change. If no drawing elements are selected, the entire drawing

elements will change.

o When you right-click on a selected element in the drawing, the function
[Notes & Dimensions Style] will become available for you to select from

the context menu.

o The settings you have set here will not be applied on the elements in the

newly created drawing.
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13.3. Exporting as 2D Drawings

InfiPoints can create drawings, and export them as 2D drawing data (DWG/DXF formats) and
background image data (PNG format). Exported background image data (PNG) can be used as
an image to be placed in the background for AutoCAD and BIM softwares.

1. Select [Output Creation] tab > [Export] > [2D/3D Drawing] ( r_‘; ) from the Ribbon menu.

— O X

S & & Ye

I
Start Video | High Resolution Project Viewefl Export
Creation Image File  File = =

Video Data Export *  Point Cloud
* 2D/3D Drawing |

rf
e
", BIM Model
153
1

CAD Model

©  Polygon Maodel

Only when "Edit Drawing Mode" is enabled, 2D drawing data (DWG/DXF

O formats) and background image data (PNG format) are exported. When
executing "Normal mode", only the drawing data (DWG/DXF format) is
exported.

2. Select the 2D drawing to be exported from the [Tree (Overview)] panel when multiple 2D
drawings are in the panel.

Tree H

Owerview  Pipe  Plane  Structure  Duct

=& Model

E||:| Scans

- w-Mg Group?

.[~&7 Extracted Planes

. L[/ Extracted Piping System

El Drawing

MlE drawingz.dwg (y=0 side view)

1 19| drawing3.dwg (y=0 side view)
M2 drawing4.dwg (x=0.00y=1.00 2=0.00)

3. "Export" dialog will appear.

#2 ELYSIUM © 2023 Elysium Page 155 | 200



Elysium InfiPoints Operation Manual Vol.2.

Point Cloud Utilization - Simulation & Data Utilization -

&P Export *
Savein: | Sample w | (€} ¥ M~
l MName Date modifi.. Type Size
Mo items match your search,
Quick access
Desktop
™
Libraries
This PC File name: ~ | | Save I
’ Sawe as type: Drawing File (*.dwg) w Cancel j|
Network
Save Path

Click [Option] to display "Import/Export Settings" dialog.

Set options and click [OK].

Import/Export Settings

Export DWG/DXF (2D/3D) File

DWW G/DXF File Version: | AutoCAD 2007/LT2007 w

[ specify resolution of background image

Widkh | 2000 pixels

Please be noted that it may take long to expork
images with high resolution.

[Jconvert 20 drawing coordinate system to 30

Load Defaults Save Defaults
el | (1RG50

click [Save]. 2D drawing file and background image will be exported.

"

MNetwork
Sawe as type: Drawing File (*.dwa) Cancel _I
Drawing File [ .dwg) - =
DXF File (" .dd Options

Save Path

¢

4. In "Export" dialog, specify folder path to save, file name, and file type of 2D drawing, and

When exporting the background image, always use "Edit Drawing Mode".
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13.4. Exporting as 3D Drawings

The created modeling elements can be exported as drawing data (DWG/DXF format).
In this case, the modeling piping element will be exported in DWG format.

1. Select [Output Creation] tab > [Data Export] > [Export] > [2D/3D Drawing] ( | ) from the

ribbon menu.

— O ot
& B
High Resolution Project Wiewe
Image File File =
Point Cloud

' 20/3D Drawing
™ CAD Model
i Polygon Model

30 Drawing

2. "Export" dialog will appear. Change the file type to "Drawing File (*dwg)", then specify the
destination and file name.

@ Export

*

Quick access

Desktop

Libraries

5

This PC

@

Metwork

© i m

o

Marme Date modified

Mo items match your search.

<

Type

File name: |Sample_out dwg w |

Save as type: |Drawing File {* dwg) V|

Options

Save Path

3. In "Export" dialog, click [Options].

File name: |Sample_out.dwg w | | Save I
Saveastype:  Drawing File (" dwg) v | Cancel |

Save Path
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"Import/Export Settings" dialog will appear. Select [Export DWG/DXF (3D) File] tab.
Here you can set options to export 3D drawing files.

Because the piping element is exported as solid in this case, enable "As solid model" under

"How to export piping elements".

Import/Export Settings

Export DWG/DXF (3D) File

(O as axis

Export Common DWG/DXF File Version: | AutoCAD 2007/LT2007

How to export piping elements

(®) As solid model

Fit all connecting points of straight pipes

e

4. Select [Export Common] tab. You can set export options for each modeling element here.

This time, leave the default settings as is, and click [OK] in "Import/Export Settings" dialog.

Import/Export Settings

Export DWG/DXF (30) File Export Target
Export Commeon
Assembly

Piping

Plane
Structure

Duct

Load Defaults

Only Displayed Elements

¥

Export all B-rep elements as a single part

[JExport each Piping Group separately

] Export piping elements in displayed colors

As solid model

[JExport planes in displayed colors

[ Export structure in displayed colors

[JExport each Duct Group separately

[JExport duct elements in displayed colors

As solid model

Save Defaults

Cancel

Apply

5. In "Export" dialog, click [Save].

File name: |Sample_out dwg

Save as type: Drawing File (* dwg)

Cancel
QOptions

Save Path

Drawing data is exported in the specified DWG format.
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&«

| = | Sample

Home Share View

v 4 <« Local Disk (C:) » ELYSIUM » Sample

Mame
3+ Quick access

~

D Sample_cut.dwg

» @ OneDrive
> [ This PC

» |_ﬂ Metwork

In "Import/Export Settings" dialog, select [Export Common] tab. Check the
option "Export each Piping Group separately" and export the 3D drawing
file. Each piping group can be exported independently as a separate 3D

drawing file

Import/Export Settings

Tree

Export DWG/DXF (3D) File Export Target

Export Common
Assembly

Only Displayed Elements

Export all B-rep elements as a single part

I Piping

Export each Piping Group separately I

Overiew Fipe  Plane Structure Duct

=T
-G
w-MT
-
-
o
E
E

I =
-

S
=ME

B--E Extracted Piping System ~

Piping Group: 5

, Piping Group: 52

Piping Greup : 67
Piping Group : 62
Piping Group : 112
Piping Group : 150
Piping Group : 171
Piping Group : 178
Piping Group : 290 v
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[C] Export piping elements in displayed colars

| = | Sample_out

« - vt

> s Quick access
@ OneDrive

[ This PC

[_} MNetwork

View

« Sample » Sample_out

Marne

[ 1_5.dwg

[ 152.dwg
[ 1.67.dwg
[ 1_68.dwg
[ 1 M2.dwg
[ 1_150.dwg
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13.5. Importing 2D/3D Drawings

You can import 2D as well as 3D drawing data into InfiPoints.

13.5.1. Importing 3D Drawings

1. Select [Import] tab > [Data Import] > [2D/3D Drawing] ( '1"_ ) from the Ribbon menu.

| 23 © ~ Smart Filter * FInfiPc

Home Import Pre-process Analysis

T e, wep D e 1) Merge Project Files
¥ Ny Re | R

Point CAD Polygon) 2D/3D
Cloud Maodel Model |Drawing

Data Import

2. "Import" dialog will appear. Specify the target drawing file to import, and click [Open].

& Import et
Look in: | sample ~ | [ W5 = T
* Marme - Date modified Type
. D Sample_2D(XY).dwg 6/23/2020 11:24 PM DWG
Quick access [ g5 nle 3D(Planes).dwg 6/25/2020 11:24 PM DWG
Desktop
m
Libraries
This PC
‘ < >
MNetwaork
File name: Sample_3D{Planes).dwg w | | Qpen I
Files of type: DWG/DXF File (" dwg,”.df) ~ Cancel
QOptions
Save Path

3. "Position of the Model" dialog will appear. In this case, specify "At the absolute coordinate of
the model" and click [OK].
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i

Pasition of the Model

() At the center of the current view

(®) At the absolute coordinate of the model

(") At a spedified position (paint / reference paint)

Place perpendicular to the estimated normal of adjacent points

Cancel

Please note that "Position of the Model" dialog will appear only when
importing 3D drawings.

3D drawing file is imported and displayed on both [Tree (Overview)] panel and "3D View"

window.

Tree

Overview  Pipe

Plane Structure Duct

E--E Model
BD Scans

-B7 Drawing

w103 Groupl

[10E Structure

% Filtered_points

5] Duct System

of drawing cannot be edited in InfiPoints.

Please note that the imported 3D drawing files are displayed as "This
drawing includes 3D elements ([4)" on [Tree (Overview)] panel. This type

Select [Home] tab > [Display Status] > [Display Method of Drawings] to
display the extracted planes.

#2 ELYSIUM © 2023 Elysium

Import

)
Home Fre-process

Fit Change |1, . o
View v }'

View Operation
Tree

Overview Pipe Plane Structure Duct

T Mote / Dimension ™

7 InfiPoints -

Analysis Modeling Cutput Creation

TR EEEEENE

3 _l S =]

20 Wireframe (Drawing)
0 1| Wireframe [Drawing)
W Shading (Drawing)

li Shading =Wireframe [Drawing)

¢ Show Intersection with 30 Drawing
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13.5.2. Importing 2D Drawings

1. Select [Import] tab > [Data Import] > [2D/3D Drawing] ( -vL ) from the Ribbon menu.

—

@ ~ Smart Filter ~  FInfiPc
- Home Import Pre-process Analysis
}. -‘7 } % Merge Project Files
Point CAD Polygon) 2D0/32D
Cloud Model Model |Drawing
Data Import

2. "Import" dialog will appear. Specify the target drawing file to import, and click [Open].

W Import

*

Quick access

Desktop

™
Libraries

This PC

=

Metwork

Loak in: |

X
sample - | e m
MName - Date medified Type
| Sample_2D(XY).dwg 6/25/2020 11:24 PM DWG
| Sample_3D(Planes).dwg £/25/2020 11:24 PM DWG
< >
File name: Sample_2D{XY).dwg w | | Qpen I
Files of type: DWG/DX¥F File (* dwg,” dxf) ~ Cancel
QOptions

Save Path

2D drawing file is imported and displayed on both [Tree (Overview)] panel and "3D View"

window.

Tree

Overview  Pipe

Plane Structure Duct

=13 [Model
—|:| Scans
4. Group?
5.3 Drawing
[ ]

Sample 3D(Planes).dwg (x=0.00y=0.0(
Sample_200XY).dwg (x=0.00y=0.00 z=

s Filtered_peints
JA13E Structure
L.[AE) Duct System
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If 2D drawing (¥2) is imported as a 3D drawing ([#), click [Options] in
"Import" dialog. In "Import/Export Settings" dialog, enable "Import as a 2D

drawing".
| Sample_2D(XY).dwg - | I Cpen I
 DWG/DXF File (".dwg," ) ~| | Canedl

A Save Path

Import/Export Settings

Impart DWG/DXF File
IIrnport as a 2D drawing I

[]1mport unitless drawing files v

Unit System Millimeter |

Select [Display Settings] in either [Top View] or [Front View] panel, and
check the option "Show 2D / 3D drawings" to display the drawing on either
[Top View] or [Front View].

it | | Update | [ & |
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13.6. Generating Point Cloud from Drawing

With InfiPoints, you can generate point clouds from drawings. By generating a point cloud on a
2D drawing, it becomes possible to perform 3D measurement from the point cloud scanned by a
laser scanner and the point cloud generated from the drawing.

1. On [Tree (Overview)] panel, right-click on the 2D drawing from which to generate the point
cloud. Select "Generate Point Cloud from Drawing" from the context menu.

Tree H

Cwerview Pipe  Plane  Structure  Duct

B--E Model
EI[:| Scans
&3 Group?
El[j Drawing
i @ drawing18.dwg (t=2 side view)

Fit Wiew to Model size

Edit name

Reset Rotation

Show/Hide part

Hide unselected parts

Fit Clip Box to Drawing
Owverlay Drawing on Clip Box...

Export Drawing...

Replace drawing with new...

Generate Point Cloud from Drawing...

Nelets

2. "Generate Point Cloud from Drawing" dialog will appear. Specify the interval to produce
points and the color of point cloud, and click [OK].

Generate Point Cloud from Drawing x

Produce points at every | 0.001 = o
Point doud display color Set color

Concel
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The point cloud is generated in the specified interval and displayed on both "3D View"
window and [Tree (Overview)] panel.

Tree

Crverview  Pipe

Plane  Structure  Duct

=-p1E Model
55107 Seans
¢ @3 Group
13 Drawing
Dﬁ drawing18.dwg (t=2 side view)

N
e

Filtered Dc@ts

= Extracted Points from drawing18.dwg.poc I

Structure

[ Duct System
Q If the point cloud generated from the drawing is difficult to see on "3D

View" window, hide the other elements on the structure tree.

Please note that the option "Produce points at every" is only available for

line data, such as 2D drawings or drawings where only the axes of
modeling elements are output.
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14. Creating a Movie

Multiple viewpoints can be set on "3D View" window, and a movie can be created by connecting
the viewpoints. For example, a movie that looks as if you were actually walking through the
scanned site can be created. This functionality is convenient in sharing information between
the client and the on-site worker before construction.

Preparing Movie Creation

» Select [Output Creation] tab > [Start Video Creation] ( % ) from the Ribbon menu.

Output Creation Recent

6 Diametrt Dimension | abe Text ‘ Ay Notes & Dimensions style % Q
L Angular®s i ; )

el
‘ Start Video Upload
Creation -

Video Cloud Fundtion

[Motion] panel and [Path] panel will be displayed.

Motion |

Execute Show  Motion Name Start time  Play Time  End time  Target

*||=- D & | |H e | Y| SB
Pause at where it colides

Save collision detection result

00:00.00 = 00:00.00
> = B
Path x|
CONIE AR AR RN S - ARE - RGNS SRS YaRiF ] Show angle by |Relative angle to path [ UritSystem m ]
Mode X Y Z Yawangle Picchangle Rollangle Break.. Time Difference ... Align ... Interpolate rotation
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14.1. Creating Motion

1. In [Motion] panel, press [Add] (| ¥ |).

Execute  Show Motion Name Start time  Play Time End time  Target

[+]-]

Pause at where it colides
Save collision detection result

00:00.00 |7 00:00.00

HE =

The current motion will be added to the list on [Motion] panel.

Execute  Show  Motion Name Start time  Play Time End time  Target

[ v Motionl 00:00.00  00:00.00  00:00.00  Viewpoint I

[+][=]

* Right-click on [Motion Name] in the [Motion] panel to change the name of

the motion.
Q Change Name >
Execute  Show Motion Name Start time
@- ' MI | Carry-in Equip. Z |
Rename
Fit View to Motion Path oK I | |

* Multiple motions can be created.

* Check "Execute" checkbox to select motion(s) to play.

i

Execute | Show  Motion Mame Start time
% v Carry-in Equip. Z 00:00.00
O v Carry-in Equip. Z-1 00:00.00
O v Carry-in Equip. Z-2 00:00.00
] v Carry-in Equip. Z-3 00:00.00
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* Check "Show" in [Motion] panel to toggle show / hide the motion path in
"3D View" window.

Motion
Execute )| Show | Motion Name Start time
v Carry-in Equip. Z 00:00.00
O Carry-in Equip. Z-1 00:00.00
O v Carry-in Equip. Z-2 00:00.00
O Carry-in Equip. Z-3 00:00.00

Motion selected in [Motion] panel will be shown with light blue line, and
others in orange.

* To delete a motion, press [Delete] (| = |) while the motion is selected on the
list of [Motion] panel.

Motion Motion
Execute Show  Motion Name Start time Execute Show  Motion Name Start time
v Carry-in Equip. 7 00:00.00 v Carry-in Equip. Z 00:00.00

z = : O Carmy-in Equip. Z-1 00:00.00
Carry-in Equip. Z-2 00:00.00 ’

Carry-in Equip. Z-3 00:00.00

[ Jes] i) ) Bl [vo B EEEEW

#2 ELYSIUM © 2023 Elysium Page 168 | 200



Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

14.2. Creating Path

1. Select one motion in [Motion] panel.

| Execute

Showe

Start time  Ply Time

End time  Target

Motion Name

The selected motion name will appear in [Path] panel.

o) 3] = o 1 6 [ )

Node X Y

Z  Yaw angle

Please note that if [Path] panel does not appear, select one motion in
[Motion] panel and press [Switch to [Path] Panel] (|F)).

[#][=]

2. Press [Edit Path (Create New/Extend Existing Path)] (

r# ) in the [Path] panel.

IEI LAl -“{ 4 |0 Show angle

Node X Y Z Yawangle Pitch angle Rollz

3. "Create New Path" dialog will appear. In this case, select "Horizontal plane" in the working
plane, and then click [Next].

Create Mew Path >

Specify the working plane

(®) Horizontal plane
(") vertical plane

() Spedify any plane
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- [Horizontal plane] fixes the Z-axis location and creates the path at the same height.
o [Vertical plane] creates the path on the vertical cross section.

o [Specify any plane] creates a path parallel to the selected plane. This is useful when
creating a path along a slope.

= Use the settings in the [Option] panel to change the way to create the
path.

opon @
ﬂ_& Option

Layout plane
Direction: (®) Horizontal () Vertical

Q () Specify any plane

Rotate: [deq]

Snap Angle: |Ever_||r45deg'ees v|

How to tum at nodes
(®) Break at node
[+] Rotate smocthly at node
() Tum smoothly &t node

4. Click an area in "3D View" window to set as an origin.
Select a point on the floor in this case.

0 An origin refers to the reference point of the height when the plane is
viewed from top in the "Section Mode".

5. The cross section plane at the height of the origin is shown in the "Section Mode".
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6. In [Section] panel, use the slide bar in "Move" to adjust the position of the section in order to
create the path at the preferred height.
Section x|
2| (3% 0482 o5

Hide points outside section [~] Section Mode

Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area

(C)Plus side @ Minus side () with thickness

Thickness | 0.1 =
Move

- - Pitch | 0.1 =

180 =

[ UnitSystem m ]

0 Please note that the path height set in "Move" of [Section] panel can be
changed from the "Z" axis which is displayed in [Path] panel after creation.
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7. Left-click the mouse on "3D View" window to specify the first point of the "node" (points
where the motion path follows).

8. "Extend Existing Path" dialog will appear. Here, select "Align to be tangent to the path
direction" and click [OK].

Extend Existing Path x

Specify how to rotate the target.

(®) Align to be tangent to the path direction
() Fix the rotation angle (Don't rotate the target)

Cancel
How to Rotate the Target

Select "Align to be tangent to the path direction" and pick a point on "3D View"
window. Two nodes are registered at the same place. The target (viewpoint or model)
rotates along the angle set on those two nodes. (Bottom left figure)

Select "Fix the rotation angle (Don’t rotate the target)" and pick a point on "3D View"
window. One node is registered and the orientation of the target (viewpoint or model)
is fixed. (Bottom right figure)

9. Continue to specify "nodes" (points where the motion path follows) by left-clicking the
mouse on "3D View" window.
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0 The red points are nodes. The path is created by connecting these nodes
and drawing a green line.

10. Click [Cancel the selection and quit this function] ( 8 ) or press [Esc] key to exit the

command.

(%] ] =] 6 I 6 (][] ] ] 2]

Show angle by | Relative angle to path

[ UnitSystem m ]

Node X
1.18600
1.18600
1.18600
0.21393
0.21393
0.21393
0.21393
6.02986
6.02986
5.02986
6.02986
1.44961

[ === RN ST SR Ry

= o

Y
-+4.92837
-5.45550
-5.45559
-5.45559
-5.45559
-3.29727
-3.29727
-3.29727
-3.29727
-5.42264
-5.42264
-5.42264

Z Yaw angle

0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075
0.71075

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000

Pitch angle Roll angle

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000

0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000
0.000

Break at node

CE R REEEN

Time

00:00.00
00:00.62
00:03.62
00:04.79
00:07.79
00:10.38
00:13.38
00:20.36
00:23.36
00:25.91
00:28.91
00:34.41

Difference Time Align with path Interpolate rotation

00:00.63
00:03.00
00:01.16
00:03.00
00:02.58
00:03.00
00:06.97
00:03.00
00:02.55
00:03.00
00:05.49

A N NN

CRRANRRNNANS
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After creating a path, press [Edit Path (Create New/Extend Existing Path)] (
r# ) and "Extend Existing Path" dialog will appear.

Extend Existing Path >

Specify which end of the path to extend from.

(®) Forward
(") Backward

Q Specify how to rotate the target.
(®) Align to be tangent to the path direction
() Fix the rotation angle (Don't rotate the target)

Cancel

o Select [Forward] to add nodes from the end of the path and extend the
path.

o Select [Backward] to create new nodes on the already created path.

11. In [Section] panel, disable "Section Mode" to return to the previous state before enabling
this mode.

Section B

al |3)%a]-]4®]2] o5

Hide points outside sectior][_] Section Mode

Display the section Use Curve
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14.3. Setting Target

Set the target (viewpoint or model) for created motion. For the target, you can set a viewpoint
or an object (CAD model, polygon model, point cloud part, drawing, or group).

® Placing a Model

1. In [Motion] panel, click "Target" item and then click "Select a model..." from the drop-down
list.

Execute Show Motion Name Start time  Play Time End time  Target
| v Carry-in Equip. Z 00:00.00  00:05.67 00:05.67 JViewnoint ]

2. Select the CAD data (or the polygon data) in the [Tree] panel.

D

3. "Position of Motion Target" dialog will appear. Here, set "Use the current location of the
target" for "Positional relation with motion path", and set "Start time of the motion path" for
"The time to set the motion target to". Then click [OK].

Position of Motion Target x

Spedfy how to locate the motion target.

Positional relation with motion path:
Move the target to set its local origin on the motion
O ath

O Set a reference point, and move the target to set
the reference point on the motion path

I (®) Use the current location of the target I

The time to set the motion target to:
I (®) Start time of the motion path I

() current time of the motion path

ok || cancel
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Without changing the position of the target model, the origin of the model is placed at the
starting position of the path.

Positional Relation with Motion Path

o If the motion target (equipment model) position does not have to be
adjusted

= For "Positional relation with motion path”, select "Use the current
location of the target".

o If the motion target (equipment model) position needs to be adjusted

= For "Positional relation with motion path", either select "Move the
target to set its local origin on the motion path" or "Specify a
reference point, and move the target to set the reference point on
the motion path".

If "Specify a reference point, and move the target to set the
reference point on the motion path" is selected, the point specified
on "3D View" window is set to the position of the start time (or
current time) of the path. The motion target moves by maintaining
its relative position (distance and direction) to the specified point.

If "Move the target to set its local origin on the motion path" is
selected, the origin (local coordinates) of the motion target is set to

Q the location of the start time (or current time) of the path. The origin
of the motion target moves along the path.

Use the Move tool or the handles in "3D View" window to adjust the

position.
Move x|
Parallel move  Rotation move
®Reltive O Absolute World coordinate system
Translate distance X|U |U|Y|U ‘U|Z|U |U| £ | (m)
Pitch E 2 m

Apply Restore Clear
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Time setting

* To start from the initial set node position
Q o Select "Start time of the motion path".
* To start from a specific time during the motion play

o Select "Current time of the motion path". This will start from the
position of the specified time.
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14.4. Preview Video

You can preview the movie in the 3D View Window. Please note that this is to quickly check the
created movie and the resolution will be low.

1. Make sure the target in [Motion] panel is either the "Viewpoint" or the object name which
you want to move.

Execute Show Motion Name Start time Play Time End time [ Target
| v Carry-in Equip. Z 00:00.00  00:05.67  00:05.67 |Equip. Z

2. Enable "Execute" to play the preferred motions.

Executef Show Motion Name Start time  Play Time End time  Target
%] v Carry-in Equip. Z Q0:00.00  00:05.67  00:05.67 Eguip. Z

Please note that when the target motion is different, such as "Viewpoint"
and "CAD model", the movie can be played at the same time. Motion with
the same target cannot be played at the same time.

Execute] Show Motion Name Start time  Play Time  End time | Target
=] v Carry-in Equip. Z 00:00.00  00:05.67 00:05.67 |Viewpoint
%] v Carry-in Equip. Z (equip)} 00:00.00 00:05.67 00:05.67 |Equip. Z

3. In [Motion] panel, press [Play] (|E| ).

Save collision detection result

8
(000000 2]

[>]]S] (8]

A preview of the model moving along the path detecting collisions can be seen in the 3D
View Window.
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14.5. Editing Nodes

Prior Confirmation to Editing Path

Select the motion you want to edit and make sure the selected motion name is displayed
in [Path] panel.

Nl (Dol =] B0 ]84 [nr] A

MNode X Y Z Yaw angle

Please note that if [Path] panel does not appear, select one motion in
[Motion] panel and press [Switch to [Path] Panel] (|~ )).

Motion

Execute Shuw Mutlnn Name Start time
o | %l A Cary-in Equip. Z 00:00.00 ||

*|| - \50"-'[:"\{«“‘/5

®m Add Node Maintaining Relative Angle to Path

1. Move to where you wish to add a node in "3D View" window.

2. In [Path] panel, press [Add Node Maintaining Relative Angle to Path] (|#% |). Current
viewpoint is added to the list as a new node (here "Node 0").

Path - Carry-in Equip. Z-1 x|

N,, <€+ CRR NN 0 - IR IS fx Fvi Show angle by | Relative angle to path ~ [ UnitSystem m ]

Node X Y Z Yawangle Pitchangle Rollangle Break at node Time Difference Time Align with path Interpolate rotation
0 0.34182 -5.80663 0.58212 0.000 0.000 0.000 00:00.00 -

3. Shift the viewpoint and press [Add Node Maintaining Relative Angle to Path] (|#4 ) again.
Current viewpoint position is added to the end of the list as a new node (here "Node 1").
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Path - Carry-in Equip. Z-1 x|
SRR SRR T R - RSN AR A RIF i Show angle by | Relative angle to path v [ UnitSystem m ]
MNode X ¥ Z Yawangle Pitch angle Rollangle Break at node Time Difference Time Align with path Interpolate rotation
1] 0.24182 -5.80663 0.58212 0.000 0.000 0.000 00:00.00 - v v
1 050925 -3.33478 1.18373 0.000 0.000 0.000 00:03.05 00:03.05

- Please note that if a new node is added with [Add Node Maintaining
Relative Angle to Path] (|4 ), the relative angle of the path reflects the
same value as the previous node. However, 0 degrees is set for the node
added first in the list.

0 o Interval from the previous node to the newly added node is set with
"Align with path" enabled.

- When added, existing nodes are adjusted so that the relative angles of
the path do not change.

m Add Node Based on View Angle

1. Move to where you wish to add a node in "3D View" window.

2. In [Path] panel, press [Add Node Based on View Angle] (| % ). Current viewpoint is added to
the Path list as a new node (here "Node 0").

Path - Carry-in Equip. Z-1 x|
N_, <=‘_ - 3| e b( ¥uj Show angle by | Relative angle to path v [ UnitSystem m ]
MNode X ¥ Z Yawangle Pitch angle Rollangle Break at node Time Difference Time Align with path Interpolate rotation
1] 0.24182 -5.80663 0.58212 0.000 0.000 0.000 00:00.00 -

3. Shift the viewpoint and press [Add Node Based on View Angle] (| ¥ |) again. Current
viewpoint position is added to the end of the Path list as a new node (here "Node 1").

Path - Carry-in Equip. Z-1 x|
A CRRC SRS E - AR NIE YR Show angle by | Relative angle to path v [ UnitSystem m ]
MNode X ¥ Z Yawangle Pitch angle Rollangle Break at node Time Difference Time Align with path Interpolate rotation
1] 0.24182 -5.80663 0.58212 0.000 0.000 0.000 00:00.00 - v
1 050925 -3.33478 1.18373 -98.055 -40.475 -18.031 00:03.20 00:03.20

o Please note that if a new node is added with [Add Node Based on View
Angle] (| %)), the angle of the path is set based on the viewing
direction.

0 o Interval from the previous node to the newly added node is set with
"Align with path" disabled.

- When adding a new node, existing nodes are adjusted so that the
absolute angles of the path relative to world coordinates do not change.
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® How to edit existing path in 3D View Window

1. In [Path] panel, press [Edit Path (Modify Existing Path)] (|~ ).

2. In [Option] panel, specify the direction in which the node is placed and how to update the
node angle.

L, oston
Layout plane

Direction: (®) Horizortal () Vertical

Fiotate: o E [deg]

How to update node angles
(®) Mairtain the relative angle to the path

() Mairtain the absolute angle in world coordinate

3. To add a new node, click any position on the path.

To move a node, drag it.
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® How to extend path

1. In [Path] panel, press [Edit Path (Create New / Extend Existing Path)] (|fz= ).

2. "Extend Existing Path" dialog will appear. Specify which end of the path to extend from and
how to rotate the target, and then click [OK].

Extend Existing Path

Specify which end of the path to extend from.

(®) Forward
() Badkward

Specify how to rotate the target.
(®) Align to be tangent to the path direction
() Fix the rotation angle (Don't rotate the target)

Cancel

3. A guide and [Option] panel will appear on "3D View" window. In [Option] panel, specify the
direction of the node and whether it will be break at node or not.

2 ELYSIUM © 2023 Elysium

Option
ﬁ-ﬂ- Option
Layout plane
Direction: (®) Horizontal () Vertical
() Specify any plane
Rotate: 1238 = [deg]
Snap Angle:  |Every 45 degrees v

How to tum at nodes
(®) Break at node

Rotate smoothly at node
() Tum smoothly at node
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Please note that when selecting the option "Break at node" in "How to Turn
at Nodes", the node will be set as the break at node (Bottom left figure).
When selecting "Turn smoothly at node", a smooth curve is created (Bottom
right figure).

Enable "Break at node" option by clicking "Break at node" column in [Path]
panel to break at the corresponding node instead of making a smooth turn.
(exclude Node 0)

IE‘ [CIRNREE -] IE‘ Show angle by‘Relat'rve angle to path

Node X Y Z Yawangle Pitch angle Rollangle |Break at nodell Time

1} 1.18600 4.92837 0.71075 0.000 0.000 0.000 00:00.00
1 1.18600 -5.45559 0.71075 0.000 0.000 0,000 v 00:00.62
2 1.18600 -5.45559 0.71075 0.000 0.000 0.000 00:03.62
3 0.21393 -545559 0.71075 0.000 0.000 0.000 v 00:04.79

4. Click anywhere on "3D View" window to add a path. Click [Cancel the selection and quit this
function] ( Q ) or press [Esc] key to exit the command.
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® How to delete nodes in 3D View Window

1. Select the node you want to delete from the list on [Path] panel, and press [Edit Path (Delete

Node)] (

o

BE‘@ Show angle by|RelaI:iveangLetopath V| [ UnitSystem m ]
Mode T X Y Z Yawangle Pitch angle Rollangle Bresk at node Time Difference Time Align with path Interpolate rotation
0 1 L8600 4000 01025 o000 0000 0000 00:00.00 -

1 1.18600 -5.45559 0.71075 0.000 0.000 0.000 00:00.63 00:00.63
5.4 g i a0

0.21393 -3.29727 0.71075

wd ks
R N

>

For multiple selection, hold down [Ctr]] or [Shift] key.

2. If two or more nodes remain after deletion, the following dialog will appear. Here, select
"Update maintaining the relative angle to the path".

Delete Node *

o Specify how to update the remaining nodes

Deleting selected node(s) will change the path shape arocund the deleted
node(s). Please select how to update the remaining nodes.

— Update maintaining the relative angle to the path

— Update maintaining the absolute angle in world
coordinate

Cancel

The selected node is deleted, and the nodes positioned after the deleted one move up. The
angles of all nodes remain the same because they are updated to maintain their angles
relative to the path.
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lEHEHZ‘E‘ ShowangLeby|Relaﬁvealdetopaﬂ| V| [ UnitSystem m ]
Node X Y Z Yawangle Ptchangle Rolangle Breakatnode Time Difference Time Align with path  Interpolate rotation
0 1.18600 4.92837 0.71075 0.000 0.000 0.000 00:00.00 - v v
1 1.18600 -5.45550  0.71075 0.000 0.000 0.000 00:00.62  00:00.52 v e
2 1.18600 -5.45559 0.71075 0.000 0.000 0.000 00:03.63 00:03.00 4 v
3] 0.21393 -3.29727 0.71075 0.000 0.000 0.000 00:10.38 00:06.75 v v
4 0.21393 -3.29727 0.71075 0.000 0.000 0.000 & 00:13.38 00:03.00 v v
5 6.02986 -3.29727 0.71073 0.000 0.000 0.000 v 00:20.36 00:06.97 v 'l
6 6.02086 -3.29727 0.71075 0.000 0.000 0.000 ¥ 00:23.36 00:03.00 v v

Please note that when selecting "Update maintaining the absolute angle in
world coordinate", the angles of all nodes are corrected based on the
absolute angle of world coordinates.

Delete Mode *

o Specify how to update the remaining nodes

Deleting selected node(s) will change the path shape arcund the deleted
node(s). Please select how to update the remaining nodes,

— Update maintaining the relative angle to the path

— Update maintaining the absolute angle in world
coordinate

0 EEE@ Show angle by |Relative angle to path | [ UnitSystemm ]

Node X Y Z Yawangle Pitchangle Rollangle Break atnode Time Difference Time Align with path Interpolate rotation
0 1.18600 4.92837 0.71075 0.000 0.000 0.000 00:00.00 - v v
1 1.18600 -5.45559  0.71075 0.000 0.000 0.000 & 00:00.63 rd v
2 1.18600 -5.45559 0.71075 65.754 0.000 0.000 00:03.63 v v
3 0.21393  -3.29727  0.71075 -24.246 0.000 0.000 00:10.38 rd v
4 0.21393  -3.29727 0.71075 0.000 0.000 0.000 00:13.38 v v
5 6.02086 -3.29727 0.71075 0.000 0.000 0.000 00:20.36 00:06.97 v '
6 6.02086 -3.29727 0.71075 0.000 0.000 0.000 ¥ 00:23.36 00:03.00 v v
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14.6. Creating a movie file

To export the movie in .avi file

1. In [Motion] panel, press [Create a movie file] (| & ).

Motion % |
Execute Show Motion Mame Start time  Ply Time  End time Targe?
v Carry-in Equip. Z 00:00.00  00:34.41  00:34.41  Viewpaint
|- \‘.‘) & ¥ | | R |vaw | v
Pause at where it colides
Save collision detection result
00:00.00 %] 00:05.67
> ]
2. "Create a movie file" dialog will appear.
Specify the frame rate and the time to start and finish the movie.
Create a movie file, >
AVI Setting
Frame rate 30 fps
Time
Start time
Specify the resolution from the list, and click [Create].
Resolution
(®) Select from a list.
540x430 {4:3)
D Input
B00x600 (4:3)
1280%960 (4:3)
1600x1200 (4:3)
426x240 (16:9)
640x360 (16:9)
Point Cloud Derfi 85480 (16:9)
1280x720 (16:9)
1920x 1080 (15:9
0%
Cancel Exit
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3. "Save" dialog will appear. Specify the movie file and click [Save] to output the movie file in

.avi format.

&« v 4 « InfiPoints » Sample
Organize = MNew folder

MName
3 Quick access

¢@ OneDrive
> [ This PC

d MNetwaork

<

P Please specify the filename of the AV file to export.

v O Search Sample

Date modified

Mo items match your search.

File name:|| Sample.avi

Save as type: | AVI File(*.avi)

A Hide Folders

Save

Cancel
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15. Exporting Files

15.1. Exporting High Resolution Images

This function allows you to export the content displayed on "3D View" window as a high

resolution image.

1. Select [Output Creation] tab > [High Resolution Image] ( r’; ) from the Ribbon menu.

Qutput Creation Recent

=0}

abe Text I ,f't,;; Motes & Dimensions style

Start Video
Creation

Video

T2

High Resolution fProject Viewer |
File  File~

Data Export

2. "Output Image" dialog will appear. Specify the image size and grid, and then click [Save].

Output Image

Image Size (pixel)

width 1600
Height 1184
Keep Aspect Ratio
Grid
Show Grid

Grid Width 5 |m
Grid Height I:' m
Grid Color

Main Line -

Sub Line

The number of sub lines between two main lines

>

Orign  x |6.016694] y 6.4151960| 7 62677284 |4

Save Cancel

Grid is only available with Ortho mode ( j ).
The display method can be changed in [Home] tab > [Display Method] >

[Ortho View Mode].

3. "Output Image" dialog will appear. Specify the image filename, and then click [Save].
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@ Exportimage X
<« v < |nfiPoints » Sample v Search Sample »
Organize = Mew folder 4= - 9
Mame Date medified Type
7 Quick access
Mo iterns match your search,
o Onelrive
[ This PC
¥ Network
< >
File name: | Samplell v
Save astype! | PNG File(".png) ~
~ Hide Folders Cancel

Image file will be exported in .png format.
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15.2. Exporting Projects

You can export a new project by copying only the required files from currently-opened project.

Preparation for Exporting Projects

» The only files that will be copied to the new project are the files associated with the
elements displayed on "3D View" window. Make sure that only the elements you want
to export are visible on "3D View" window, and if necessary, switch the display state of
each element using the icons in [Home] tab > [Display Method] group.

- |Smart Filter - i'?lnfiPDints

Pre-process Analysis Modeling Cutput Creation

rall : |j = '“"|:|' 'E'ﬂ 'j'j' -13
View~ | ¥ " |E"E|" ~\6h -z § | EEG |E

View Operation Display Status

* By unloading the point cloud with scan index before exporting, you can reduce the
data size of the new project.

Tree ] Tree a
Ovenview Pipe Plane Structure Duct Overnview Pipe Plane Structure Duct
-5 Model =5 Model

=3 Scans 203 Scans
P =-7] Group1

=-i

vl LS07364_020
N LSo7384 021
M Ls07364_022
MA# 1507364 023
A LS07364 024
N7 Lso73s4 025
M Ls07364 026

x Mots 1507364 027
4|7 Extracted Planes |7 Extracted Planes
[ Extracted Piping System -1 Extracted Piping System
- [~e% Filtered_points [ Filtered_points

Please refer to [Managing Project Data] > [Saving Projects] > [Unload Point Cloud with
Scan Index] in "Elysium InfiPoints Operation Manual Vol.1 Data Pre-processing" for
more details on how to unload point cloud with scan index.

1. Select [Output Creation] tab > [Data Export] > [Project File] ( f' ).

Cutput Creation Recent Help

Text Motes & Dimensions style " — ﬁ
I"IultiL 1.‘) ﬁ';] II.-: - % |MpE

Start Video = High Resolutior§ Project fViewer Export
Creation Image File File o

Video Data Export

2. "Export Project" dialog will appear. Specify the output folder and the output options, and
click [OK].
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Export Project >
Output Folder |C:’~.InﬁPoints\SampIe Erowse
Export target Visible elements only

[] Generate background paint doud

Cancel

Refer to [7. Creating Optimal Point Cloud Data for Drawing] > [7.1 Creating

Q Background Point Cloud Data] in "InfiPoints Operation Manual Vol.1 Data
Pre-processing” for details about the option "Generate Background Point
Cloud".

By displaying only the point cloud with scan index created with [Decrease
LI

Resolution of Point Cloud with Scan Index] ( ®%e ) and exporting it as

another project, the data size of the project can be significantly reduced.

ExportProject_decreased_resolution_peointcloud

Exp ExportProject_decreased_resolution_pointcloud Proper... X

General Sharing Securty Previous Versions  Customize

ExportProject_decreased_resolution_pointcloud

Type: File folder
Location: CAELYSIUMINfiPoints'\Sample

| siz=: 13.1GB (14,096, 210,974 bytes) |

Size on disk:  13.1 GB (14,096,338,544 bytes)

; ExportProject_decreased_resolution_pointcloud

ExportProject_criginal_pointcloud

ExportProject_ocriginal_pointcloud Properties *

General Sharing Securty Previous Versions Customize

Export Project_original_pointcloud

Type: File folder
Location: CAELYSIUMINfiPoints\Sample

| siz=: 146 GB (1,574,954 370 bytes) |

Size ondisk:  1.46 GB (1,575,030,784 bytes)

Please refer to "InfiPoints Operation Manual Vol.1 Data Pre-processing" >
"Managing Project Data" > "Reducing the Data Size of Point Cloud with Scan
Index" for more details.

Refer to [7. Creating Optimal Point Cloud Data for Drawing] > [7.1 Creating

Q Background Point Cloud Data] in "InfiPoints Operation Manual Vol.1 Data
Pre-processing” for details about the option "Generate Background Point
Cloud".

New project will be exported as the specified folder.
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A new folder will be created under the name of "<specified name>_<a serial
number>" if the folder with specified name already exists.

(Example) The folder named "sample_1" will be exported if the folder
named "sample" already exists in InfiPoints folder.

I 4 = | Elysium
Hame Share View
0 — v » ThisPC » Local Disk (C:) » Elysium *
Mame
7+ Quick access
INFIPOINFTS
¢@ OneDrive InfiPaints_data

E This PC InfiPoints_data_new

Sample
3D Objects
- ! Sample_1
[ Desktop

Temp
Documents
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15.3. Exporting Viewer Files

Export a viewer file from InfiPoints to share the point cloud with users without an InfiPoints
license.

Preparation for Creating the Viewer Files
m Create a viewing file while retaining the point cloud

* Create filtered point cloud data.

By creating the Viewer File from filtered point cloud, the data size of Viewer File can
be greatly reduced.

Tree a
Overview Pipe Plane Structure Duct

=-E Model

E|D Scans

ED Group1

-5 2015021741
-, 20150217A-2
-l 201502174-3
-y 201302174-4
[ 20150217A-5
-7 20150217A-6
[, 201502174-7
[7c7 Extracted Planes
[ [ Extracted Piping System
! :}Eﬁ Filtered_points

Please refer to "Learn with Tutorial" > "Vol.1 Data Pre-processing" >
Q [Creating Point Cloud Data Optimized for Visualization]" for more
details about creating filtered point cloud data.

Check Off the checkbox of point cloud parts except filtered point cloud data in [Tree
(Overview)] panel.

Tree n
Overview Pipe Plane Structure Duct
-5 Medel

b7 Seans

B..

M5 2015021741

N 2o150217A-2
N 20150217A-3
N5 2015021744
H00:5% 20150217A-5
H00:5% 2015021746
M0 2o150217A-7

A Extracted Piping System
[/ Filtered_points
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m Create a viewing file without retaining the point cloud

* Create a texture image for planes and pipes.
By exporting the viewing file with only texture, the data size of the viewing file can be
further reduced than when the optimized point cloud data for visualization is used.

(Reference) Example of file size comparison for viewing files

o Viewing file created from a source point cloud: 12.9 GB
> Viewing file created from an optimized point cloud for visualization: 1.37 GB

o Viewing file created from a texture image (without point cloud data): 0.71 GB

o When using a computer which does not have a high 3D graphics
performance, it is recommended to output the viewing file in texture.

Q Please refer to 4, Creating and Editing Texture for more details about
creating texture images.

In [Tree (Overview)] panel, disable all point cloud parts, and then export the viewing
file.

Tree x|
Overview Pipe Plane Structure Duct

B--S Model
=17 Scans

|E|..
N Lso7364_020
N Lso7364_021
N Lso7364_022
N Lso7364_023
Ns Lso7364_024
10s% Lso7364 025
W% Lso7364 026
W% Lso7364 027
|7 Extracted Planes

[ [] Extracted Piping System
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1. Select [Output Creation] tab > [Viewer File] ( rl" ) from the Ribbon menu.

- O X
= [ A (i3 [
Start Video | High Resolution Projecl Wiewer Export
Creation Image File File = bl
Video Data Expd ¢ Viewer File |

£ WViewer File for VR

2. "Export Viewer File" dialog will appear.
Specify the location of the file and the operations permitted to the viewer, and click [OK].

Export Viewer File >

Output Folder | CiTempiviewer_201831014-154747 Browse

Functions to enable Enable measurement

Allow creation and export of drawing files

Allow export of image files

Export target Visible elements only

Cancel

‘ Functions to enable can be set for Viewer Files. Please note that the file is
—_ not encrypted nor protected by any means.

o When the checkbox is checked off for point cloud parts not to be exported
in the structure tree, check "Visible elements only" of export option.

3. Viewer files are exported.
Double-clicking the .vbs file in the exported folder starts the viewer.

| @ = | Viewer 201380 -

Hame Share View

“« v 4 <« ELVSIUM 3 InfiPoints » Sample v O Search Sample
Narme Date modified Type
7 Quick access
data 2019/08/29 11:57 File folder
@ OneDrive | StartinfiPointsViewervbs | 2019/08/29 11:57  VBScript Script

[ This PC
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Viewer File Functionality

Scanning Division / Company

* Scanning banat
* Pre-processing e
point cloud data z

2 . =g
“ W Elysium
InfiPoints.

Measuring distances,
diameters etc. for
their needs

Visualization
File

. View point cloud, CAD data, notes and dimensions
. Switching between show/hide of layers

. Section movement along a pre-set path

1
2
3
4. Drawing creation, DWG export [*]
5. Ortho image export [*]

6. Adding dimensions [*]

7

. Adding notes

[*] Authority settings can be conducted when exporting the viewer file

» The viewer file has the same point cloud rendering capabilities as
that of InfiPoints.

o » Users can save drawings, notes, and added dimensions in the viewer
file.

» Distribute both the .vbs file and the folder that includes the data file
for the viewer file.
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15.4. Exporting as CAD Models

You can export the created modeling elements in various CAD formats such as IGES, STEP, and
IFC. In this case, the modeling elements are exported in IGES file.

Native CAD export is an optional product. By selecting [Supported Formats
(Import/Export)] ( 4 ) at the top right of InfiPoints window, a list of file types

that can be input/output with current license is displayed.

; |4 * |Smart Filter - §infiPoints
Home Import Pre-process Analysis Modeling Output Creation  Recent

O && @ « |&
Learn with FAQ  Customer Version Supported Formatsg Get
Tutorial~ Page  Information~| (Import/Expol Log

Learn Support Information Log

1. Select [Output Creation] tab > [Export] > [CAD Model] ( ﬁ ) from the Ribbon menu.

process Analysis Modeling I Output Creation I Recent Help
mensions style % q [ ﬁ; f—ﬁ [
E :] —7

start Video Upload High Resolution Project Viewel
Creation E1 Image File File
Video Cloud Function Data Export . Point Qoud
r* 2D/3DPrawing
r, BIM el
|7 cap mode |
% Polygon Model

2. "Export" dialog will appear. Change the file type to "IGES file", and specify the destination
and the file name.

Save As x
« A <« temp > sample v | 0 2 Search sample
Organize New folder &= - (7]

7 Quick access Mo items match your search,

@ OneDrive
3 ThisPC

[_} Metwork

File name: | sample

Save astype | IGES (“.igs, ".iges)

A Hide Folders Option... Cancel

3. In "Export" dialog, click [Options].
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File name: | sample

Save as type: | IGES (*.igs, *.iges)

# Hide Folders

Option... Cancel

"Import / Export Settings" dialog will appear. Select [Export IGES File] tab.
It is possible to set export options for IGES file here.

@ Option
Advanced

[] Display all available options

IGES Exporter

File Version | IGES Expaort (IgesFileVer) 2
Use default value

11: 5.3

Topology Conversion | MSBO: Type186 (WriteMSBO) 2
Use default value

®) 0: Always ignore the adjacency relations
) 1: Convert volumes in MSBO format

) 2: Check whether it is manifold, and convert in MSBO format if it is manifold

Sub-figure (WriteSubfigure) ?

Use default value

) 0: Don't use subfigure.

® 1: Write Volume as subfigure,
() 2: Write Assembly as subfigure.
() 3: Write Assembly as subfigure{Except 1-part case)

Additional Parameter

N =0

| ok || cancel |

You can configure export options for the file type corresponding to the
specified file type.

9 Import/Export Settings

You can configure export options for each modeling element in [Export Common] tab.
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Impert/Export Settings bt
- Impart Export Target Only Displayed Hlements
E| Export .
.. Export Common Assembly [ Export all Brep elements as a single part
- Export Meutral File Piping [ Export each Piping Group separately
- Export 5TL File
. Export OBJ File [ Export piping elements in displayed colors
----Export‘u‘RML File . [ As solid model
- Export Point Cloud File
. Export E57 File Plane [ Export planes in displayed colors
- Export PTX File
... Export PTS File Structure [ Export structure in displayed colors
- Bxport LAS/LAZ File Duct [ Export each Duct Group separately
- Export EYEpeints File
- Export Rebro File D Export duct elements in displayed colors
- Export CADWe'll Tfas File [ &s solid model
.- Export IFC File solameds

.- Export DWG/DXF (2D/3D] Fil:
- Export DWG/DXF (3D) File

- Export Revit File

- Export FBX File

.. Export 30 PDF File

- Export ReCap File

- Common for CAD model

Load Defaults Save Defaults

Concel | | fonly

Options are also configurable from [Application Menu] > [Option] >
[Import/Export Settings].

-| iy (% ~ \Smart Filter - EinfiPoints -
(s
New % System Settings...

Q . 'F' Open Project... % Display Settings...
H Save.. 4 "1\9 Import/Export Settings...
Clean up Project @ License Setting..,
H Print... »

@:% Option 3

E3 Exit

In "Import/Export Settings" dialog, click [OK].

4. In "Export" dialog, click [Save] to export the CAD model in the specified IGES file type.

File name: ‘ sample \,|
Save as type: | IGES (".igs, ".iges) ~
~ Hide Folders Option... Cancel
0 If there are multiple CAD data elements in the project file, all the elements

will be exported.
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All rights reserved by Elysium or the original author of this material. The content may not
be edited, reproduced, distributed, transmitted, displayed, published, broadcast, sold or
lent without the prior permission of the author.
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